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Release notes 
This document includes all updates of SMART Estimator, including technical releases not publicly available. 

Version 2023.0 November 2023 

SMART Estimator 2023.0 (Build 294) November 2023 

The following enhancements have been made in this version of SMART Estimator:  

1. This public update includes all the features for the previous beta versions.  Please see below. 
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Version 2023.0 beta 2 October 2023 

SMART Estimator 2023.0 (Build 283) October 2023 

The following enhancements have been made in this version of SMART Estimator:  

1. Improved save performance for auto-save / saving a local copy of a project. 

2. Improved performance when closing the address book without changes. 

3. Made the logs smaller by reducing the types of message logged by default. 

4. The address book is now pre-loaded as SMART Estimator is launched, so address book 
performance is improved. 

5. Shrinking the SMART Estimator window size while File > Projects is open now adds one 
fewer vertical scrollbar. 

6. Minor improvement to the speed of rendering the File menu. 

7. Minor tweak to the layout of the installer progress screen. 

8. Fixed a set of bugs related to changing your server settings while the address book is still 
open. 

9. Bug fix: Qualifications set in Schedule IT for circular tanks now display correctly in the quote. 

10. Bug fix: Added the last save date when a RAMS project is saved. 

11. Bug fix: corrected a tooltip for the configuration user guide button. 

12. Bug fix: The follow-up projects button on the Welcome screen now works correctly. 

13. Bug fix: Opening SMART Estimator with a slower internet connection and creating a new 
project very quickly no longer causes SMART Estimator to hang / crash. 

14. Bug fix: Corrected one error message for RAMS. 

15. Bug fix: dragging two ladders so they overlap can no longer cause a crash. 



 Release notes 

 GLOBAL CONSTRUCTION 
SOFTWARE AND SERVICES 3    Copyright © Computer and Design Services Limited 

Version 2023.0 beta August 2023 

SMART Estimator 2023.0 (Build 192) August 2023 

The following enhancements have been made in this version of SMART Estimator:  

1. SMART RAMS (Risk Assessments and Method Statements) has been restored. 
This module was temporarily disabled for alpha testing. 

2. The Invoicing Link user guide has been added to the Help menu. 

3. SMART Estimator has been updated to use the latest version of Microsoft Local DB. 

4. Some of the brand colouring on the default quotation template has been updated so it is 
easier to change the colour. 

5. Bug fix: Adding lead-ins in Schedule IT now works correctly. 

6. Bug fix: UNC file paths are now supported as the location for a legacy Windows Enterprise 
data store. 

7. Bug fix: Inside toe boards are now removed when the inside guardrails are set to None. 

8. Bug fix: Fixed a specific sequence which could cause address book edits to fail. 

9. Bug fix: Deleting qualifications in Schedule IT can no longer cause a later crash in Quote IT. 

10. Bug fix: Creating variations now works even for a custom variable extension. 

11. Bug fix: The project status is now always clearly displayed as a dropdown. 

12. Bug fix: File > Projects never displays multiple nested horizontal scrollbars. 

13. Bug fix: Saving a project no longer changes the start date unexpectedly. 

14. Bug fix: The short top lift option in the apply to all row of Schedule IT now works 
consistently. 

SMART Estimator API 23.0.0 August 2023 

The following enhancements have been made in this version of the SMART Estimator API:  

1. RAMS is now supported, with new API endpoints for access, edit and deletion of: 

1.1. The configuration list of people that may be harmed by a hazard. 

1.2. Risk assessment template layout files. 

1.3. Method statement template layout files. 
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Version 2022.6 alpha (Build 5) June 2023 
The following enhancements have been made in this version of SMART Estimator: 

Alpha Build 
  
The RAMS (Risk Assessment and Method Statement) module is disabled for this alpha update.  
An announcement will be made in a future update on the future of SMART RAMS. 

1. Bug fix: After changing the quantity for an item in Schedule IT, Price IT is now updated 
correctly. 

Version 2022.5 alpha (Build 66) April 2023 
The following enhancements have been made in this version of SMART Estimator:  

Alpha Build 
  
The RAMS (Risk Assessment and Method Statement) module is disabled for this alpha update.  
An announcement will be made in a future update on the future of SMART RAMS. 

1. The Risk Assessment and Method Statement functionality is disabled for this update. 

2. Project grid sorting: Following feedback, by default the project grid is now sorted by quote 
number, rather than last save time. 

3. Bug fix: When opening projects from much older versions of SMART Estimator, the quote 
number is no longer corrupted. 

4. Bug fix: Fixed an issue that could cause chimney stack cladding to change after closing and 
re-opening the project. 

5. Bug fix: Fixed a crash after editing a quote and copying the project item. 

6. Bug fix: Editing the project status and re-saving now immediately updates the projects grid. 

7. Bug fix: Editing the pricing and re-saving now immediately updates the projects grid. 

8. Bug fix: Fixed an issue where clause editing would sometimes fail to save. 

9. Bug fix: Fixed an issue where editing a component name would sometimes fail to save. 

10. Maintenance: Updated to the latest version of one of the Microsoft login packages. 
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Version 2022.4 alpha (Build 255) January 2023 
The following enhancements have been made in this version of SMART Estimator:  

Alpha Build 
  
The RAMS (Risk Assessment and Method Statement) module is disabled for this alpha update.  
An announcement will be made in a future update on the future of SMART RAMS. 

1. The Risk Assessment and Method Statement functionality is disabled for this update. 

2. SMART Estimator is significantly faster when using SMART Scaffolder cloud storage. 

3. When creating a new project, the project no longer sometimes fails to be created because 
the quote number is no longer available. The main part of the quote number is now hidden 
by default.  This is now generated when you press Create Project. 

3.1. To choose your own quote number, you can use the Edit (pencil) button. 

4. The Follow-up date is now more prominent when creating a project.  This is intended to 
make the feature easier to find. 

5. Bug fix: SMART Estimator no longer loses the cloud licence after running continuously for 24 
hours. 

6. Bug fix: SMART Estimator no longer sometimes crashes after running continuously for 24 
hours. 

7. Bug fix: Editing the width of a Cuplok birdcage in Schedule IT no longer sometimes causes 
SMART Estimator to crash. 

8. Bug fix: Adding multiple chimney stacks to the same project item no longer sometimes 
causes SMART Estimator to crash in Quote IT. 

9. Bug fix: Adding beams as extra materials (rather than by adding a bridge, loading bay or 
temporary roof) now causes the Beam fixing labour price line to appear. 

10. Bug fix: The Material list and drawings Email As: RTF, XLS and XLSX now work correctly. 

11. Bug fix: Applying an access deck no longer causes the tool to duplicate itself in the Access 
Deck menu. 

12. Some changes have been made to speed up future server upgrades. 

13. All projects are now unlocked during a server upgrade. 

Version 2022.3 (Build 67) October 2022 
The following enhancements have been made in this version of SMART Estimator: 

1. The following changes have been made to the profit section in the item pricing report: 
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1.1. Stock Losses (Material) 

This new price line is a percentage of the material hire. 

1.2. Stock Losses has been renamed to Stock Losses (Labour). 

Version 2022.2 (Build 38) October 2022 
The following enhancements have been made in this version of SMART Estimator: 

1. This public update includes all the features for the previous beta versions.  Please see below. 

Version 2022.2 beta (Build 38) September 2022 
The following enhancements have been made in this version of SMART Estimator: 

1. Improved the reliability of the tool for checking for updates. 

2. Added per metre and per foot pricing options to the 13’ ladder beam component. 

3. Fixed an issue when changing scaffolding system in Schedule IT if some names are used for 
scaffolding system configurations. 

4. Fixed an issue saving and generating a material list for some very tall scaffolds. 

5. Elevations no longer detach from the rest of the independent when an elevation image is 
added, and the scaffold is hidden. 

6. Improved the positioning of attached chimney stack scaffolds in the 3D exports. 

7. Fixed a rare crash that occurs for some L-shaped scaffolds. 

8. Fixed a rare crash that occurs when splitting some elevations. 

9. When applying brickguards multiple times to the same lift, the materials no longer change. 

10. Tweaked the ladder position for reversed independents so the ladder no longer clips through 
the toe board. 

11. When using the Email As option, a warning message is now shown if Microsoft Outlook is 
already launched with incompatible privileges, explaining how to correct the issue. 

12. Fixed an issue when editing quote templates with specific sizes of image present. 
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Version 2022.1 beta (Build 198) July 2022 
The following enhancements have been made in this version of SMART Estimator: 

1. Quotation letters from older versions of SMART Estimator are no longer laid out incorrectly.  
A message asking estimators to re-check their quote layout is no longer shown. 

2. Switching from loading bay drawings to another scaffold type drawings no longer causes the 
dimensions to move. 

3. Fixed the address book search box so it no longer reverses the text that you typed. 

4. The auto update app is digitally signed. 

5. Fixed an issue with birdcage lift area pricing calculations for multi-lift birdcages. 

6. Fixed an issue with the Scaffold Type dropdown in Schedule IT. 

Version 2022.0 beta (Build 148) June 2022 
The following enhancements have been made in this version of SMART Estimator:   

1. Windows 11 is now supported. 

2. Tube and Fitting loading bays have been updated to the NASC TG20:21 style.  This includes 
options for: 

2.1. Styles: with and without beams; 

2.2. Widths: 8 and 10 (6 + 2 and 3 + 4 + 3) boards wide; 

2.3. Bay lengths: 2 x 2.00 m, 2 x 1.80 m, 2 x 1.50 m, 4 x 0.90 m and 4 x 0.75 m. 

2.4. Scheduled loading bays; 

2.5. Attached 3D modelled loading bays; 

3. It is now possible to force a project to unlock.  This can only be done if the project was 
locked by you, using your current Windows login credentials on this computer. 

3.1. This is helpful when, for example, a power outage causes a project to become locked and 
SMART Estimator is no longer open. 

4. The Model IT user guide has been split in two: the basics are in the Model IT user guide, 
while more complex features have been moved to Model IT: Advanced. 

5. The software application name (the “executable” name) has been changed from ModelIt.exe 
to SMART Estimator.exe. 

6. Hardware key (i.e. dongle) licences are no longer supported.  A cloud licence is now 
required. 
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7. Launch speed has been improved when connected to cloud storage. 

8. An issue causing the wind map to sometimes not appear has been fixed. 

9. The look of base plates on independents has been improved when high visibility (safety) 
standards are present. 

10. The layout of rakers has been improved when hop-up platforms are present. 

11. When checking for updates, the layout of text has been improved for the release summary. 

12. Double sole boards and sole pads have been corrected to look better in the 3D model. 

13. Fixed a subtle pricing issue with birdcages when labour is priced using m2 of lift area.  This 
issue mainly affected system scaffolds.  This price is now consistent for birdcages with the 
same final dimensions, even when the input dimensions (the “area to fill”) are different. 

14. Scheduled system loading bays now have an inner ledger on scheduled structural lifts.  This 
is an improvement, since the parent scaffold is unlikely to have a ledger at this position. 

15. Improved the message when a server upgrade fails. 

Version 2021.4 (Build 4) April 2022 
The following enhancements have been made in this version of SMART Estimator:   

1. Fixed a graphics issue occurring on some AMD graphics cards. 

2. Fixed a pricing issue with the temporary roof cover fixing price line – this was sometimes 
resetting unexpectedly. 

3. Fixed an issue with mouse zoom when no Schedule IT licence is present. 

4. Fixed an issue with the Reset to Factory Settings tool. 

Version 2021.3 (Build 153) March 2022 
The following enhancements have been made in this version of SMART Estimator:   

1. Project search (File > Projects) has been improved: 

1.1. By popular demand, the Find button has been restored.  It is possible to search using this 
button or by pressing Enter or Return in the search box. 

1.2. Search is now exclusive – projects not found using your search are now hidden from the grid 
completely. 

2. Fixed an issue where the projects grid loading spinner could spin forever. 
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Version 2021.2.1 (Build 187) December 2021 
The following enhancements have been made in this version of SMART Estimator:   

1. Fixed an issue preventing saving in some cases on remote Windows storage. 

2. Fixed a problem when switching to Medium or Low graphics quality with some graphics 
cards. 

Version 2021.2 (Build 163) October 2021 
The following enhancements have been made in this version of SMART Estimator:   

1. The Projects tab on the file menu has a new layout, making it clearer and easier to use. 

2. When projects are being loaded, the Projects grid now shows a message and a spinner. 

3. Projects are now loaded into the Projects grid much faster, especially when using SMART 
Scaffolder cloud storage. 

4. The Projects grid can now be exported as a CSV file. A CSV file can be opened in Microsoft© 
Excel©, for example. 

5. The grid of components in the Configuration tab can be exported to CSV.  The Pricing view 
and the Details view can both be exported. 

6. A new tool is available in the Model IT > Tools view – the Square Corners tool.  Use this tool 
when some corners of your elevations are almost, but not quite right angles.  It will square 
the corners, saving scaffolding material. 

7. A new tube colour is available – Orange.  This colour can be set from the Model IT > Options 
view.  As usual, you can set different tube colours for different scaffolding systems. 

8. In the event of a power outage, or if SMART Estimator is closed unexpectedly, a project may 
become locked.  Projects now unlock automatically after 24 hours. 

9. The temporary roof button is now correctly hidden in Draw Plan mode when using a 
scaffolding system other than Tube and Fitting. 

Version 2021.1 (Build 123) June 2021 
The following enhancements have been made in this version of SMART Estimator:   

1. A new Continue where I left off button has been added.  Use this to easily re-open the 
project you were working on last. 
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Version 2021.0 (Build 217) May 2021 
The following enhancements have been made in this version of SMART Estimator:   

1. A new Pavement lift tool has been added to Model IT.  Apply this tool to an independent to 
adjust the first lift height and add safety lights and high-visibility safety standards in one 
action. 

1.1. It came to our attention that some customers were unaware of the option to change the 
safety standard type (in Model IT > Options). The default has therefore been changed to 
yellow safety foam for all customers.  You can change this back by applying one of the other 
types. 

2. The Guardrails menu has been updated with new tools for creating and removing roof edge 
protection.  Use these tools to add (or remove) edge protection, update the drop height and 
set the edge protection type in one action. 

3. A new Recess tool has been added to Model IT.  Apply this tool to an independent to add 
hop-ups set to fill a small gap (recess) in the elevation. 

3.1. Recesses can now be resized by dragging the ends. 

3.2. The appearance of brickwork around recesses has been improved. 

4. A graphics fix has been applied.  This bug took effect on some computers, disabling “anti-
aliasing”, making the 3D model less smooth.  This has been fixed so all customers should 
now see the same smooth 3D models. 

5. Colours and lighting have also been improved. 

6. A Repair server tool has been added to the Server Tools application.  This tool automatically 
fixes common issues with shared SMART Scaffolder Enterprise data. 

7. Launch time has been improved.  Launch no longer waits for the number of projects with a 
follow-up reminder to be checked. 

8. Bug fix: Importing maps no longer fails for some Irish postcodes. 
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Version 2020.3 (Build 106) October 2020 
The following enhancements have been made in this version of SMART Estimator:   

1. Temporary roofs are now available for Tube and Fitting! 

1.1. Temporary roofs can be clad with sheeting, corrugated sheets or no cladding; 

1.2. Only mono-pitch roofs are available, but multiple roofs can be placed in the same 3D model 
and aligned as required. 

1.3. Pricing, material lists, quotation descriptions, 3D model and scheduling are all supported for 
tube and fitting temporary roofs. 

1.4. Manual temporary roofs have been removed to make way for the new scaffold type. 

2. SMART Estimator now auto-saves. 

2.1. Don’t risk losing data in a power outage. Auto-save saves copies of your work regularly. 

2.2. Retrieve auto-saved files using a new option in the File > Open menu. 

2.3. Choose where, how many and how often auto-saves are made using new options in File > 
Settings. 

3. The add-ons quotation descriptions have been improved. Some cases that would produce 
long lists of scaffolds are now much shorter. 

4. Check IT TG20:13 and Check IT TG20:13 Plus have been updated: 

4.1. The TG20:13 summary sheet style has been updated. It is now styled more like the TG20:13 
certificates (available if you have the Check IT TG20:13 Plus licence). 

4.2. The TG20:13 summary sheet and certificate sign-off section can now be filled out using 
SMART Estimator. 

4.3. The TG20:13 summary sheet and certificates are shown together in a new PDF control. 

4.4. All of these Check IT changes are part of preparation for the release of TG20:21 next year. 

5. Quotes and settings can now be shared using the SMART Scaffolder Cloud! 

5.1. Just login with your SMART Manager user name and password, and SMART Scaffolder will 
share your data with the rest of your estimators. 

5.2. Control who can access your data using SMART Manager. 

5.3. Don’t have a SMART Manager subscription?  Contact sales@smartscaffolder.com today. 
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Version 2020.2 (Build 111): May 2020 
The following enhancements have been made in this version of SMART Estimator:   

1. BIM Toolbox has received the following major improvements: 

1.1. Import 3D building models, then trace around them to create scaffolding quickly and make 
stunning images. 

1.1.1. Only IFC 2x3 files with metric units are currently supported.  For performance, there is a 
maximum mesh count on imported building models. 

1.2. Export your 3D model as an interactable 3D PDF, which can be opened by your customers 
using PDF software, including the free version of Adobe Acrobat Reader.  

1.3. Export the 3D model to 3D DWG, which can be edited in AutoCAD. 

1.4. Export your 3D model as an interactable 3D HTML, which can be opened by your customers 
using any major internet browser.  

1.5. All three new exports may optionally include the imported building model. 

2. Track who is changing your files.  The Projects grid (File > Projects) now shows the date, time 
and windows username of the last person to edit a quote. 

3. Faster launch time: SMART Estimator now launches much faster, especially if you are using a 
cloud licence.  (Legacy hardware keys “dongles” are slower to read). 

4. It is no longer possible to close the File menu until you have created or opened a project. 

Version 2020.1 (Build 993): February 2020 
The following enhancements have been made in this version of SMART Estimator:   

1. SMART RAMS is a new module for generating Risk Assessments and Method Statements.  
Content for this module was produced in association with Safety & Access Ltd. 

2. Double boards and double boards with sheeting (sandwich boards) can now be placed on 
scaffold lifts.   

2.1. For tube and fitting independent scaffolds, these are TG20:13 compliant provided they are 
placed on a pavement lift. 

3. A new pricing method per lift is available in Price IT.  This simple method prices scaffolds 
only by the number of lifts, so it is useful for simple standardised pricing. 

3.1. Scaffolds priced per lift can be optionally priced by height band, and the structural lifts can 
be priced separately, using the existing pricing labour options. 

4. Company logos (or other images) can now be added to the sheeting. 
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5. Quadruple guardrail options are available for tube and fitting, Layher and Kwikstage 
scaffolds. 

6. Quote IT has been improved: 

6.1. New SMARTText fields for section titles can be hidden automatically when there are no 
scaffolds present (or only ‘manual’ scaffolds). 

6.1.1. This new option is available for the Decking, Access and Loading titles. 

6.2. The adaption description now explicitly states when adaptions are set as not included. 

6.3. The add-ons description now explicitly states that add-ons have not been allowed for when 
none are present. 

7. Cuplok hop-ups now include stabilisation ledgers on the end of the bracket where 
connections are available. 

8. HAKI scaffolds have new guardrail options for un-boarded lifts: None, Single and Double 
guardrail frame. 

9. By popular demand, the address book now defaults to Display as a List. 

10. The search box on the configuration tab is now always visible, to make it easier to find. 

11. Fixed an issue with undoing multiple actions on any items after the first. 

12. Fixed revised quotes, so the creation date is updated and the start date is not. 

13. Fixed a very rare issue that causes some SMART Estimator files to fail to open correctly when 
double clicked. 

14. Fixed a complex sequence where a banded price line could become hidden but still 
contribute to the price of the scaffold. 

15. Improved the drawing layout for dimensions, especially when the text size is increased. 

16. Fixed an issue where installation would fail for the first person to install per day. 
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Version 2020.0 (Build 945): December 2019 
The following enhancements have been made in this version of SMART Estimator:   

1. Check and download updates from within SMART Estimator: 

1.1. An option to check for any new updates and download the latest has been added.  

1.2. The installer is now lightweight and faster to download and install.  

2. Support for proxy servers for using Cloud license: 

2.1. SMART Estimator can be now configured to use a proxy server to validate a cloud based 
license. 

3. A few performance related tune-ups have been added and this should help lessen the initial 
launch time for SMART Estimator. 

3.1. If you are not using any hardware licence keys, SMART Estimator can be configured to not 
check for them, which will increase the launch speed. 

4. Report IT has been better aligned to fit on wide 4K monitors. 

5. The 3D model no longer flickers for some combinations of graphics card and monitors. 

Version 2019.3 (Build 633): May 2019 
The following enhancements have been made in this version of SMART Estimator:   

1. Revisions and Variations are now fully supported.  These new types of quotes are derived 
from an existing “parent” quote: 

1.1. A revision has the same content as the original quote until edited but a different, related 
quotation number. 

1.2. A variation is a new fresh quotation, but with a related quotation number. 

1.3. To support this, quotation numbers now have 5 parts:   

1.3.1. Prefix – Number – Suffix – Revision – Variation 

2. Rakers are now available for Tube and Fitting independents. 

2.1. Rakers to the second or first lift are now available, replacing tie positions, as shown in Fig. 
6.62 and 6.64 of the TG20:13 Operational guide.  

3. “Road and building” maps can now be imported and traced over using BIM Toolbox.  Snap 
points are included around buildings to speed up tracing the building perimeter. 

4. Improvements when creating a new quote: 
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4.1. When creating a new quote (project), you can now specify more information immediately, 
including: the contract number, description, pricing rates to use, creation date, start date, 
and a follow-up reminder date. 

4.2. When creating a new quote or later editing the address, the user interface has been updated 
to make the function of address groups clearer.  A label now shows which address is 
currently selected, and how many addresses are in the current group. 

4.3. Revisions and Variations of existing quotes can now be easily created from the File menu > 
New tab. 

5. Improvements in managing existing quotes: 

5.1. The layout of the grid for opening and editing quotes has been improved. 

5.2. Quotes can be copied with a new quotation number. 

5.3. A revision for a quote can now be created. 

5.4. A variation of a quote can now be created. 

5.5. Quotations can now be more easily grouped into folders (categories). 

5.6. It is easier to create and re-name categories (folders). 

5.7. Quotes can be dragged and dropped into folders (categories). 

5.8. A new Undo Sorting button has been added, to return you easily to the default layout of the 
grid. 

6. The Hire Period can now be set when specifying an item in Schedule IT > Summary View. 

7. The lead-in for an item can now be removed in Schedule IT > Summary View. 

8. The term “Contract number” has been replaced everywhere by “Quote number” for clarity. 

9. The Price IT > Item pricing report now stretches to fill all available width.  This should allow 
larger numbers to fit in the price boxes for most displays. 

10. Draw Plan helper lines (for drawing 90 degree angles) now show even if the grid is active.  
This should make it easier to line up elevations correctly. 

11. CADS is continuing to review and improve how SMART Estimator looks and works on high 
resolution and high scaling displays.  In many cases, the layout has been improved to 
accommodate high resolution (“4k” and “8k”) displays. 

12. The Project Browser no longer includes an image of the scaffold, instead showing the item 
ID. 

13. SMART Estimator now uses Microsoft PDF Printer for generating PDFs if available.  PDF 
Factory is no longer used.  This improves the look, particularly for semi-transparent 
watermarks. 
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14. Draw Plan 90 degree snapping now works for the second elevation.  Previously only the third 
elevation and later would snap. 

15. The final graphic on the installer has been improved. 

16. The stacked tubes image on the Project Browser has been removed to make the interface 
cleaner. 

17. A rare issue that caused the TG20:13 summary not to appear the first time it was opened has 
been fixed. 

18. An issue that would cause the split elevation grips to vanish in some circumstances has been 
fixed. 

19. The default loading for Plettac Metrix loading bays has been updated to match the latest 
guidance. 

20. Addresses will now always show in File > Address Settings once they are set. 

21. A rare issue that would cause the material list to show error E03001 has been fixed. 

22. An issue that caused edge protection guardrails to be offset from the top of the elevation by 
too much has been fixed. 

23. The materials list layout on 4k monitors has been improved. 

Version 2019.2 (Build 262): February 2019 
The following enhancements have been made in this version of SMART Estimator:   

1. An export is available to the following accounting packages:  

1.1.1. Sage 50 desktop 

1.1.2. QuickBooks 

1.1.3. Xero 

1.2. This export is a CSV file for a Sage Audit Trail log, a Xero invoice import or a QuickBooks 
invoice import. 

1.3. The new Invoicing link licence is required to access this feature. 
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Version 2019.1 (Build 229): December 2018 
The following enhancements have been made in this version of SMART Estimator:   

1. A new “Item ID” column has been added to the Schedule IT grid, allowing items to be 
assigned IDs other than the default “1”, “2”, “3”, such as “6a”, “6b”, “6c”, etc. 

1.1. The quotation includes a new Item ID SMARTText field to allow this new ID to appear in the 
quotation.  

2. System scaffolding hop-up brackets can now be scheduled by size and material, instead of 
number of decks.  This allows more control over the brackets and decks you want to use. 

3. A new component is available for Tube and Fitting called “Kentledge”.  This new component 
must be switched on through the Configuration tab before it can be used.  It is available as 
an Extra Material to be added to the material list. 

4. New Readylok transoms are available for Tube and Fitting: 

4.1. XTENDA intermediate transom 1000m (4 + 3) 

4.2.  XTENDA intermediate transom 1000m (5 + 3) 

4.3.  Readylok transom: 3-board 

5. Improvements in Plettac Metrix: 

5.1. The connection positions in standards are now placed to avoid lift levels. 

5.2. A new 0.5m wide hop-up bracket has been added. 

6. A new style of edge protection guardrails is available for Tube and Fitting: X-frame. 

7. Fixed a bug that could cause some tabs to vanish after editing the addresses through the File 
menu. 

8. Fixed an issue that would cause the Enterprise server data to be updated unnecessarily 
when installing SMART Estimator 2019 with SMART Estimator 2017.0 – 2018.3 already 
installed. 

9. Fixed an issue with the material list when changing from Tube and Fitting to Plettac Metrix 
with hop-ups present. 

10. Pricing rates are no longer listed as “This Project Rates(Name)” when they have no changes. 

11. Fixed a crash when connecting to a brand new, never used server that you did not install. 

12. Fixed an issue with the email created by Quote IT > Email As PDF sometimes having no body 
text. 
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Version 2019.0 (Build 62): October 2018 
The following enhancements have been made in this version of SMART Estimator:   

1. SMART Estimator 2019 has a new look.  A new style and new icons used on all buttons. 

2. SMART Estimator 2019 is sharper and clearer on high-resolution displays. 

3. This product has been called SMART Estimator for some time.  This version makes this name 
more prominent.  The following have been renamed to SMART Estimator: 

3.1. The installed application name is SMART Estimator 2019. 

3.2. The installation directory is SMART Estimator 2019. 

3.3. The server tools application is called SMART Estimator Server Tools 2019. 

4. 32-bit Windows is no longer supported.   

4.1. 32-bit editions of Windows are no longer supported, so SMART Estimator will not install on 
these systems.  The more common 64-bit editions are still supported.  View the system 
requirements http://links.smartscaffolder.com/systemreq, for more information. 

5. Fixed an issue where under certain conditions the price would change on saving and 
reopening a project for the first time. 

6. Fixed an issue where the fonts and table styles would sometimes change when opening the 
quote print preview. 

7. Fixed an issue where changes to the columns shown in the scaffold dimensions table were 
not saved correctly to the quotation template. 

8. Fixed an issue in pricing extra materials for quotes created in older versions of SMART 
Estimator. 

9. Fixed an issue where the customer telephone and email was sometimes not updated to 
match the contact after first creating a quote. 

10. Fixed an issue where add-ons could not be removed from all scaffolds at once in Schedule IT. 

11. Improved the message shown when exporting the quote to a PDF that already exists and is 
read-only. 
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Version 2018.3 (Build 14147): August 2018 
The following enhancements have been made in this version of SMART Scaffolder:   

1. 3D chimney stack scaffolds are now available for Tube and Fitting. 

1.1. These chimney stack scaffolds can be created through the 3D model or schedule and include 
a number of options for different types of access. 

2. A 1.5m lift option is now available as a tick box in the Schedule IT Height column. 

Version 2018.2 (Build 12107): April 2018 
The following enhancements have been made in this version of SMART Estimator:   

1. Improvements in scheduling: 

1.1. A new First lift height field is available so the first lift height can be changed without 
switching to custom lift heights. 

2. Improvements in BIM Toolbox: 

2.1. Satellite photos can now be imported in three different sizes: small, medium and large. 

2.1.1. The smaller imports are higher quality photos, but the larger ones cover a wider area. 

2.2. You can now edit an imported PDF image, satellite photo or elevation image using new tools.  
This includes: 

2.2.1. Cropping the photo to decrease the size, and 

2.2.2. Drawing on the photo with a pen. 

3. Improvements in pricing: 

3.1. A day work rate can now be set from the Labour Options menu. 

4. Improvements in quoting: 

4.1. The day work rate can now be shown using a new SMARTText field. 

4.2. All prices can now optionally be displayed as words, rather than numbers. 

4.2.1. It is possible to show both on the same quote. 

5. Improvements in Draw Plan: 

5.1. It is now possible to draw scaffolds in Draw Plan mode while the grid is hidden; 

5.2. Even when the grid is shown, points can be selected which are off the grid; 
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5.3. New “Helper lines” have been added which assist with creating 90 degree corners and 
aligning Draw Plan points. 

6. Improvements in Model IT: 

6.1. Inside guardrails can now be set differently from the outer guardrails, and can vary by lift. 

7. Cloud export pricing data 

7.1. The cloud export now contains pricing data.  Contact support@cads.co.uk if you would like 
access to this data. 

7.2. When setting the name of a contact in the address book and pressing tab, the address will 
no longer sometimes vanish, as it changes position. 

7.3. Changing the creation date for the open project using the File > Projects screen now causes 
the date to update immediately instead of on the next open. 

Version 2018.1 (Build 776): March 2018 
The following enhancements have been made in this version of SMART Estimator:   

1. Improvements in performance: 

1.1. Performance on many of the Model IT add-ons tools, including bridges has been improved. 

1.1.1. You may notice that the preview (the image shown when you hover with a 3D tool) for these 
tools has changed.  This improvement will be applied to more tools in future updates. 

1.2. For system scaffolding, the logic for choosing bay sizes has been optimised, so resizing and 
creating scaffolds is faster. 

1.3. The Draw Plan button is now available on the BIM Toolbox tab, so you no longer have to 
switch to Model IT before adding scaffolds to an imported site plan or satellite photo. 

1.4. Quote IT will now offer to automatically compress large images in quotation templates when 
you press the Edit this Quote Template button. 

1.5. Reduced the size of the download, so this update will download faster. 

2. The material list can now be sorted by product code as well as the existing component 
name. 

3. Improvements in Plettac Metrix: 

3.1. Improved the logic for choosing bay sizes, so tube and fitting infill bays are now very rare. 

3.2. Hop-up brackets with a clip instead of a built-in collar now allow inside guardrails.  A 
standard base collar is added to each hop-up. 

3.3. Attached stair towers now include an extra Internal Guardrail between the stair and the 
independent to act as fall protection. 
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3.4. Many components added, including corner filler hop-ups, façade and plan bracing and some 
updates to component names. 

3.5. Birdcages now include additional façade bracing following a clarification from the 
manufacturer. 

3.6. Loading bay un-boarded lifts now receive plan bracing if two wing braces are not present. 

3.7. The 2.5m and 3m trapdoor decks now include a built-in ladder, while the shorter 2m and 
1.5m require a separate ladder. 

3.8. Fixed an issue where the ladder would sometimes face the wrong way in 1.3m birdcage 
bays. 

3.9. Removed some unnecessary ledgers from the Plettac Metrix stair. 

4. Improvements in Quote IT: 

4.1. New Table of Items SMARTText is available.  This table summarises the name, hire period 
and price of all items in the project.  The default quote now has 3 fewer sections. 

5. Improvements in SMART Estimator Enterprise: 

5.1. The SMART Estimator client can no longer create an Enterprise data structure.  This led to 
some confusion, so installing Enterprise can now only be done through the installer, as in 
SMART Estimator 2017 and earlier. 

5.2. Fixed an issue that caused non-admin users to be unable to access an Enterprise data 
structure created by an admin user. 

6. Added a tooltip for system scaffolding bridges to let you know the available system beam 
sizes. 

7. Fixed an issue that caused very small scaffolds created in earlier versions to have no lifts. 

8. Fixed a slight delay in the stair tooltip, which meant you could hover the stair tool over a 
valid bay and it would appear to say the bay is the wrong size. 

9. Fixed an issue that caused address books that contain some special characters to fail to 
upgrade. 

10. The release notes and what’s new documents changed to website links. 

11. Fixed some minor highlighting and font issues on the front page of the installer. 

12. Made a small change to façade bracing on inside corners for system scaffolding, so the inside 
bay is skipped if it is part of the main scaffold run. 

13. Improved the loading graphic shown before the installer front page appears. 

14. Cloud licence Save and Close button changed to Save and Restart, so you can automatically 
relaunch SMART Estimator after entering a cloud licence code. 

15. Smoothed out the Schedule IT Height, Width and Add-ons controls, so they flicker less.  
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Version 2018.0 (Build 763): November 2017 
The following enhancements have been made in this version of SMART Estimator:   

1. The software name has been changed to SMART Estimator 2018.  You might notice a new 
loading “splash” panel when you start SMART Estimator 2018, as well as a slightly refreshed 
welcome screen. 

2. New features in Schedule IT: 

2.1. “Manual” chimney stacks and manual temporary roofs are now available to schedule! 

2.1.1. These two new scaffold types are available via the schedule and allow labour to be priced 
and a quote created for a chimney stack or temporary roof more easily.  

2.1.2. No 3D model or drawings are available for these two “manual” types, but materials can be 
added via Report IT, as for the existing Manual scaffold type. 

2.2. Even more flexibility to customise lift heights has been added.  Many common lift heights 
are available by selecting them with the Enter key.  Any combination of lift heights is 
possible using the new Custom option. 

2.3. It is now possible to specify which lifts are boarded instead of just the number of boarded 
lifts. 

2.4. Many add-ons can now be scheduled, including: banner, safety lamps, high-visibility 
standards, double standards, sheeting, debris netting, brick guards, cantilever fans, bridges 
and ladder positions. 

2.5. The Schedule IT UI has been streamlined.  Many columns have been removed and combined 
to make the grid easier to read and navigate. 

2.6. Schedule IT now names independent scaffolds by default as if they are connected. This does 
not affect the 3D model, load list or drawings, but does show on the price and quote. 

2.7. Scaffold and / or elevation names may now be blank.   

2.7.1. We noticed some estimators setting the elevation names as “.” or “-” to remove the 
elevation names on the quote.  This is now possible by simply deleting the name. 

2.7.2. Setting the scaffold name as blank also affects the quotation.  See the quotation 
improvements below for details. 

2.8. Edge protection scaffolds may now be up to 9999m long.  This is ten times the previous limit.  
The 3D model is not shown for a very long edge protection scaffold. 

3. The default lead-ins included with SMART Estimator have been improved.  The new list is 
inspired by C.A.S.E.  For this update, this list is only available when installing on a computer 
that has not had a previous version of SMART Estimator. 

4. Improvements in Quote IT: 

4.1. The table of Scaffold Dimensions has been improved: 
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4.1.1. The dimensions are now in clearly labelled columns; 

4.1.2. The table has a more spacious, easier to read style; 

4.1.3. Gable lifts are now more clearly separated from main lifts; 

4.1.4. Identical independent scaffold names are no longer repeated. 

4.1.5. If the independent scaffold name is blank, no row is included in the table for the name. 

4.2. The Guardrails Description has been improved: 

4.2.1. Guardrail descriptions are now clearer and shorter. 

4.3. The Lift Heights Description has been improved:  

4.3.1. Lift height descriptions are now clearer and more detailed. 

4.4. The Loading Description has been improved:  

4.4.1. Loading descriptions are now clearer and shorter. 

5. Improved pricing: 

5.1. The Project pricing grid can now be printed showing all of the columns that you have set as 
visible. 

5.2. The pie chart report is now available via a new separate button. 

5.3. The item price “breakdown” report now includes the customer and site address. 

5.4. Driving directions are now available from a new option in the Transport Options menu. 

6. Performance and workflow improvements: 

6.1. Schedule IT and BIM Toolbox are now the first tabs on the left. 

6.1.1. This means that tabs are generally used from left to right, improving the flow of the 
software.  In particular, BIM Toolbox should come before Model IT, so site plans can be 
imported before tracing scaffolds onto them. 

6.2. When copying via the Project Browser, the new item is now placed as the last item in the 
scaffold.  This much-requested improvement reduces how often you will need to re-order 
items. 

6.3. After installing SMART Estimator, the first launch is now faster. 

6.4. The database containing all of your SMART Estimator Enterprise quotations no longer 
requires Microsoft SQL Server.  This has the following benefits: 

6.4.1. Downloading and installing SMART Estimator is much faster.  The installation is now simpler, 
with fewer options. 
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6.4.2. The database is now a simple Windows directory structure, so backing up, moving, locating 
and accessing your Enterprise files is much easier. 

7. It is our pleasure to offer SMART Estimator Draw IT 2018, available free-of-charge from the 
SMART Estimator website.  This bolt on for Autodesk AutoCAD 2018 provides blocks, guides 
and tools for editing scaffold drawings using AutoCAD.  It works best when combined with 
the Draw IT link module, which creates AutoCAD files from your SMART Estimator scaffold 
drawings. 

Version 2017.1 (Build 723): July 2017 
The following enhancements have been made in this version of SMART Estimator:   

1. Guard rails are now available for foot lifts for independents, circular tanks and tied towers, 
for all scaffolding systems. 

1.1. Foot lift guard rails are available for all scaffolding systems, including tube and fitting. 

1.2. Inside guard rails can optionally be applied. 

1.3. A footlift is required to add these guard rails, but it does not need to be boarded or decked. 

1.4. When the foot lift is boarded or decked and guard rails are added, toe boards are also 
included. 

2. Split elevation grips are now available, allowing the position of a split to be easily changed. 

2.1. Dragging the split close to an elevation end will erase the split. 

2.2. These grips can optionally be hidden from the Options view. 

3. New Plettac Metrix features: 

3.1. 4-leg stair towers are now available. 

3.2. Intermediate (deck-to-deck) and intermediate (deck-to-ledger) transoms are now used for 
erecting ladder hatches. 

3.3. Components have been added to support a 1.3m bay length. 

3.4. Ledger-to-ledger side brackets are now available.  The easiest way to apply these is to 
disable all hop-ups and sliding hop-ups. 

3.5. Bridges have been updated: 

3.5.1. The beam is now placed one connection lower to facilitate connections for decking. 

3.5.2. Standards above the bridge beam are now supported by puncheons. 

3.6. Loading bay gates now include 2 x U-head ledger spigot for standards. 
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4. Draw Plan features: 

4.1. It is now easier to find common buttons.  Infrequently used buttons have been moved into a 
new menu. 

4.2. The Snap to 90 degrees feature is now disabled by default, but can be easily enabled. 

4.3. Scaffolds are now hidden by default, shown as grid lines. 

4.4. Double clicking to drop the Zoom, Rotate or Pan tools no longer finishes the independent 
that you are drawing. 

5. A new clause recommended by the NASC Contractors Legal Group has been added for new, 
fresh installations. 

6. Fixed an issue that caused the Split Elevation tool not to highlight the scaffold on hover. 

7. Copy Picture now correctly trims whitespace around the scaffold. 

8. Copy Picture and Project Browser items no longer sometimes capture pop-ups in front of 
the 3D model. 

9. Clicking the Copy button for an item now copies that item rather than the active item. 

10. Fixed some cases where saving fails.  SMART Estimator will now automatically repair any 
such files. 

11. Addressed an issue with 1st and 2nd generation Intel on-board graphics, where no separate 
graphics card is available, which would cause 50% of the 3D model space to work correctly 
and 50% to be white.   

11.1. If you face this issue, please set the Graphics Quality to Medium or Low.  Some features are 
disabled in these modes, which are not supported by these on-board graphics. 
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Version 2017.0 (Build 702): March 2017 
The following enhancements have been made in this version of SMART Estimator:   

1. The software name has been changed to SMART Estimator 2017.  You might notice a new 
loading “splash” panel when you start SMART Estimator 2017, as well as a slightly refreshed 
welcome screen. 

2. New tools in BIM Toolbox: 

2.1. Photos and other images can now be added to the front face of the building. 

2.2. A satellite photo of the site can be imported and traced on. (Requires an internet 
connection) 

2.3. Non-vector PDFs can now be imported as images. (Vector PDFs can still be imported as lines 
and traced over.) 

3. Performance: 

3.1. 3D model performance has been improved under the Windows 10 Anniversary Update. 

3.2. A new Graphics Quality setting is available from the File > Settings screen.  This defaults to 
Medium, but can be reduced to Low to improve 3D model performance, or set as High to 
improve the 3D model look. 

3.3. A new Check My Hardware tool is available from the File > Settings screen.  This tool checks 
your hardware against those required to run SMART Estimator and gives advice accordingly. 

4. New birdcage features: 

4.1. System birdcage decking can now be set to alternate in a “checkerboard” pattern.  This 
feature is available from the Boards menu in Modelling > Tools view. 

4.2.   Safety lamps, high-visibility standards and rubbish chutes are now available for birdcages. 

5. If you have Enterprise, an export to the SMART Estimator Web Console is now available 
from the File > Projects screen. 

6. For Tube and Fitting scaffolding, HAKI stair components are now shown in the Configuration 
tab, so they can be more easily priced. 

7. The layout of Quoting clauses, terms and conditions has been improved. 

8. The installer has been simplified and now has fewer screens. 

9. An issue where the site or customer address would sometimes be duplicated for Enterprise 
Server quotes has been corrected. 

10. A rare issue related to duplicated configurations when moving between offline and online 
modes causing a crash has been corrected. 
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11. The Draw Plan grid now moves so it is always centred on the last selected point, to allow 
large scaffolds to be drawn more easily. 

Version 2016.2 (Build 661): September 2016 
The following enhancements have been made in this version of SMART Estimator:   

1. Plettac Metrix Advanced Guard Rails are now available. 

These frames replace the guard rails and façade bracing. Some sizes also act as a ledger and 
toe board. 

2. The TG20:13 summary report has been updated. 

A new warning graphic has been added for scaffolds that do not comply. For clarity, a 
column title has been changed and a footnote removed. 

3. Tube and Fitting loading bays now include a foot lift, even when attached to a scaffold 
without a foot lift. 

4. The dialog for setting the body text shown on a quotation email has been improved: 

4.1. Font and styling tools are now available in the dialog. 

4.2. A menu for adding SMARTText descriptions is now available in the dialog. 

5. Some minor bug fixes are included. 

Version 2016.1 (Build 660): July 2016 
The following enhancements have been made in this version of SMART Estimator:   

1. The Turner OCTO scaffolding system is now available!  

Turner OCTO uses Bracing Guardrails to reduce required materials. 

2. When emailing a quote, the email is automatically populated with: 

2.1. A recipient taken from the customer address contact; 

2.2. A subject based on the contract number and contract description; 

2.3. Customisable text, which may include automatic “SMARTText” descriptions; 

2.4. The attached document name now includes the contract number. 

3. Quoting now includes a UK English spell checker. 

4. Performance Improvements: 
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4.1. SMART Estimator now launches faster, by completing more launch activities 
simultaneously. 

4.2. The grid of Enterprise projects now shows more quickly.  The tile view is no longer 
loaded when the grid view is active. 

4.3. SMART Estimator files and projects saved on the server are now smaller.  Only 
quotation templates that you have actually viewed or edited are saved in the file. 

5. Plettac Metrix bay logic 

Plettac Metrix is now improved to use fewer but larger bays in some cases. 

Version 2016.0 (Build 643): February 2016 
The following enhancements have been made in this version of SMART Estimator:   

1. The Plettac Metrix scaffolding system is now available!  

Plettac Metrix allows a unique divisible corner detail, so that fewer standards are required 
than for other ring systems. 

2. Performance Improvements: 

2.1. SMART Estimator 2016 is 64-bit. 

This means that SMART Estimator 2016 can make use of more memory than previous 
versions, provided that you are using a 64-bit version of Windows. 

3. Scheduling 2016 

The following improvements have been made to Scheduling: 

3.1. Lead-In descriptions 

You can now create and customise your own list of “lead-in descriptions” through the 
schedule.  Use these paragraphs of rich text to insert common descriptions into the start of 
your quotation, without having to type them. 

3.2. Schedule cantilever (hop-up) brackets 

A new column called “Hop-Up Decks” has been added to Scheduling.  You can use this 
column to add inside cantilever (hop-up) platforms to every lift of an independent, tied 
tower or circular tank, or outside platforms to every lift of a birdcage. 
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3.3. Lift creation 

In order to make creating a scaffold with the correct lifts even easier, the way that SMART 
Estimator creates lifts has been updated. 

3.3.1. The scaffold top lift height automatically adapts by default. 

Previously, SMART Estimator created all new lifts at a height of 2m by default.  For a 6m 
high scaffold, you saw 3 x 2m lifts.  For a 7.9m high scaffold, you still saw 3 x 2m lifts.  This 
logic works well for some scaffolding types, and not very well for others.   

Now, the top lift of the scaffold will adapt to match the maximum height required more 
closely. 

3.3.2. Small foot lifts or base jacks no longer cause lifts to be removed. 

In previous versions, even a very small foot lift or base jack could cause the top lift to be 
removed from a scaffold.  For example, a 4m high scaffold with a 0.09m foot lift would have 
only one lift: 1 x 2m.  A 4m high scaffold will have 2 x 2m lifts, even if it also has a small foot 
lift. 

3.3.3. Preferred Drop height 

The Drop Height column has been removed, and replaced by a new, simpler Preferred Drop 
Height column.  When the preferred drop height for a scaffold is changed, the maximum 
allowed position of the top lift is reduced by that amount.  For example, a 5m independent 
scaffold with a preferred drop height of 1m is created as if the elevation height was 4m. 

3.3.4. Fixed column order 

The option to change the order that schedule columns appear in has been removed. 

The order of columns in the Schedule is now fixed. Working from left to right through the 
grid is now the best way to choose lift heights through the schedule.  

3.3.5. Default scaffold heights updated 

The default height of most scaffold types has been updated.  For example, all four elevations 
of a box scaffold are now 4m instead of 5m.  Scaffolds created by default have the same 
number of lifts as in previous versions of SMART Estimator. 

3.4. Creating scaffolds with the Tab key 

Scheduling has always automatically added a new independent whenever the Tab key is 
pressed on the final Schedule column in the Scaffolds view.  This is a fast way to add 
scaffolds to the schedule before setting their type.  

Scheduling will now ask you whether you want to create a scaffold before adding it. 

3.5. Wider columns and horizontal scrollbar 

3.5.1. All schedule columns now show at the ‘best fit’ width by default, and can be resized as 
required. 
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3.5.2. To fit all these new columns in, a horizontal scrollbar now appears, allowing wider 
columns. 

3.6. Structural Lifts 

Lifts created automatically by SMART Estimator, when the Structural Lifts (as required) 
schedule option is applied, are treated differently.  These lifts are now considered part of the 
lift above. For example, for a 3m lift, a 2m structural lift will be inserted in to the scaffold.  
However, this lift’s height will still display as “3.00m” in the 3D model and schedule. 

3.7. Pasting scaffolds from the schedule of future versions of SMART Estimator into this 
version has been disabled. 

4. Quoting 

The following improvements have been made to Quoting: 

4.1. “Exploding” SMARTText 

It is now possible to “explode” any of the quotation descriptions that were automatically 
created for you by SMART Estimator (SMARTText) into basic text.  This means that you can 
now easily change a few words in a long SMARTText paragraph without retyping the whole 
description. 

4.2. Lead-In descriptions 

You can now create and customise your own list of “lead-in descriptions” through the quote.  
Use these paragraphs of rich text to insert common descriptions into the start of your 
quotation, without having to type them. 

4.3. Simpler widths and Add-on descriptions 

When all scaffolds / elevations / lifts in an item are similar, the Scaffold Width and Add-on 
Description SMARTText will be shorter, by not listing the scaffolds. 

4.4. Clause rich text controls 

When entering the description for clauses and conditions in the quotation, rich text editing 
controls are now provided for the Description and Group. 

4.5. Scaffold dimensions: width 

A new option is available for the Scaffold Dimensions text.  The width of the scaffold can now 
be shown or hidden. 

4.6. Scaffold width in boards 

The Scaffold Width SMARTText description now always describes the scaffold width by 
showing the number of boards wide.  Previously this format was only used for Tube and 
Fitting. 
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4.7. Add clause button 

When customising your clauses or conditions, a new Add button can be used instead of 
pressing Tab after entering a description. 

4.8. The default quotation has been updated. 

To help inspire you when customising your quotation for the first time, and to help do this 
more quickly and easily, the default Full Quotation has been updated to a new style. 

4.9. Re-order quotation sections 

The order of Quotation sections can now be changed.  This means it is now possible to add a 
new quotation section which is not at the end of your quote. 

5. Quadruple guard rails: Kwikstage and Layher 

Quad guard rails can now be placed at the top lift for Kwikstage and Layher scaffolds. 

6. Drawings improvements 

The following improvements have been made to the drawings: 

6.1. The font colour of dimensions in the drawings can now be set. 

The default colour is now black rather than light grey. 

6.2. The drawing dimension size can now be increased using a multiplier. 

For example, setting the Text Size to 1.5 increases the text dimensions to 150% of the default 
size. 

7. Cost Analysis improvements 

7.1. The Material Supply multiplier on the item pricing report was previously located on the 
Materials line.  This has been moved to the Material Hire price line, which excludes 
Contract Expenses such as transport and Material Purchase. 

7.2. The Labour Overhead column in the pie chart report is now the sum of Labour 
Overhead plus Output Pay Overhead. 

8. TG20:13 Compliance: Site Address 

The site address can also be set from the Wind Factor menu in the TG20:13 Compliance tab. 

9. Modelling improvements 

The following improvements have been made to the 3D model: 

9.1. Copy Picture 

The Copy Picture button is now available from the Modelling tab in the Options view. 
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9.2. Loading bay sizes 

Loading bay’s lengths and widths are no longer fixed values.  Instead, a loading bay may be 
any length or width for which the required components are configured in the Configuration 
tab. 

9.3. Layher Allround components 

The following new components have been added to the Layher Allround scaffolding system: 

Bridging ledger, steel: 2m 

Bridging ledger, steel: 2.5m 

Bridging ledger, steel: 3m 

Lattice beam with 4 wedge heads, steel: 3m 

9.4. Buttress ‘raker’ lifts 

The top ‘raker’ lift of a scheduled or single bay buttress no longer has a fixed height of 
2.00m.  The height can be set by hovering over the raker tubes. 

10. IT administrator tools   

It is now possible for IT administrators to disable the following functions: 

10.1. Saving locally 

It is now possible to prevent chosen users from saving projects to local directories (such as 
their desktop).  You can use this to force estimators to save to the shared Enterprise 
database instead (if you have the Enterprise module licensed).  

10.2. Editing component pricing 

You can prevent users from accessing the way that individual scaffolding components are 
priced by default. 

11. File menu 

Some control styles and layouts in the File menu have been updated, including: 

11.1. When selecting an address in File > New, a new Back button is available to cancel this 
action. 

11.2. Project address settings, such as the customer and site address can now be edited 
from the File menu, even once the project has been created. 

11.3. For users sharing quotations over the Enterprise Server, it is now easier to open 
projects.  An Open Project button has been added to the File > Projects screen. 
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12. SMART Estimator 2016: 

12.1. The software name has been changed to SMART Estimator 2016.  You might notice a 
new loading “splash” panel when you start SMART Estimator 2016, a new launch icon 
and a refreshed welcome screen.  

12.2. SMART Estimator 2016 can be installed and run on the same computer as any one 
previous version of SMART Estimator.  If you have the Enterprise module, a new 
Enterprise database will be created for SMART Estimator 2016.  If you install to the 
same location as the previous version, all of your settings and projects will be copied to 
SMART Estimator 2016. 

13. Supported operating systems  

13.1. Windows Vista not supported  

Microsoft Windows Vista is no longer a supported operating system.  This version will 
not install on a Microsoft Windows Vista workstation. 

13.2. SMART Estimator 2016 supports the following operating systems: 

SMART Estimator Enterprise Server SMART Estimator 

Windows 10 Windows 10 

Windows 8.1 Windows 8.1 

Windows Server 2012 R2 Windows Server 2012 R2 

Windows 7 (with service Pack 1) Windows 7 (with service Pack 1) 

Windows Server 2012 (with service Pack 1) Windows Server 2012 (with service Pack 1) 

14. Other improvements 

The following additional improvements have been made: 

14.1. If services that SMART Estimator requires are disabled, SMART Estimator will now 
attempt to start these at launch. 

Double clicking the project row still opens the project as before. 

15. Bug fixes: 

15.1. Fixed a crash where the maximum prefix / suffix length is exceeded; 

15.2. Fixed a crash where the maximum possible contract number is exceeded; 

15.3. Fixed a display issue where Draw Plan and BIM Toolbox red lines are too thick if no 
discrete graphics card is available. 

15.4. Fixed an issue where too many components were included in the scheduled buttress, 
included components which should be shared with the main scaffold. 

15.5. Fixed an issue where landscape PDFs imported in to BIM Toolbox were incorrectly 
stretched. 
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15.6. On steep slopes and steps in the ground, lifts which are made up of only a single pair of 
standards will now include transoms and ledger bracing as expected.  In addition, the 
lift height can now be edited. 

15.7. The PDF exports will now function correctly after installation on supported versions of 
Windows Server. 

15.8. The My Address SMARTText is now stored, and will be automatically re-applied when 
the same Windows user uses SMART Estimator, as expected.  Previously this address 
was resetting to blank. 

15.9. Fixed a grammatical error in the TG20:13 advice given for attached scaffolds taller than 
their parent. 

15.10. The TG20:13 Compliance wind factor location selector is now laid out better on low 
resolution displays. 

15.11. The clauses and conditions pop-up edit controls are now sized to better fit the 
available space. 

15.12. Fixed an issue preventing the IFC export from functioning when the site address 
includes only a postcode. 

Version 2015.0 (Build 522): September 2014  
The following enhancements have been made in this version of SMART Estimator:   

1. The software name has been changed to SMART Estimator 2015.  You might notice a new 
loading “splash” panel when you start SMART Estimator 2015, as well as a slightly refreshed 
welcome screen. 

2. This version of SMART Estimator 2015 now includes an integrated TG20:13 check, which 
checks your scaffold for TG20:13 compliance! To use this feature you must have the TG20:13 
Compliance module licensed on your hardware key.  

You must have the NEW SMART Estimator TG20:13 Compliance module licensed on your 
hardware key to use the TG20:13 features. 

3. The Check IT and Check IT Plus modules have now been discontinued.  These modules do 
not unlock any features in SMART Estimator 2015.  

3.1. The NASC no longer recommends erecting scaffolding in accordance with TG20:08.  
This guidance has been discontinued.  However, if you wish to continue using the 
TG20:08 check with your Check IT and Check IT Plus module licences, you must install 
SMART Estimator v5.31 (client only) in a separate location on your computer. 

4. Lift shafts, Free-standing towers and Tied towers are available in Modelling and Scheduling. 

Lift shaft towers 

These are butted internal scaffolds, similar to birdcages. 

(Available for all scaffolding systems except Frame Scaffolding) 
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Tied towers 

The towers may be one or two bays wide.  These are similar to independents. 

(Available for all scaffolding systems) 

Free-standing towers 

May be one or more bays long. (Available for all scaffolding systems except Frame 
Scaffolding) 

5. The wind map, used to set the TG20:13 wind factor, has been updated to include all of the 
factors required by TG20:13, including the seasonal factor, topography and surroundings. 

6. It is now possible to add brick guards through Scheduling. 

7. It is now possible to add 8-leg stairs through Scheduling. 

8. The Scaffold Dimensions description now includes some new options: 

8.1. The number of lifts can now be included or excluded from the description. 

8.2. The elevation height can now be included or excluded from the description. 

9. The Ladder Tower button in the schedule has been renamed Attached Ladder Tower to 
remove any confusion between an attached ladder tower and a free-standing tower.  
Scheduled attached ladder towers do not include any components which would be shared 
with their parent scaffold. 

10. The Loading Bay button has been replaced by Attached Loading Bay.  An attached loading 
bay does not include any materials that would be shared with their parent scaffold. 

11. The scaffold types shown in the schedule toolbar can be changed by using the new ‘scroll’ 
buttons. 

12. The Building Colour for rectangular birdcage elevations can now be set.   

12.1. For example, it is now possible to hide the four elevations around a rectangular 
birdcage, by applying the Transparent building colour. 

13. Projects created in previous versions of SMART Estimator are now automatically optimised.  
This improves the performance throughout SMART Estimator 2015.  Projects saved in 
SMART Estimator 2015 are slightly smaller as a result. 

14. Gin wheels now include a diagonal brace in the ledger direction, for all systems except 
Frame Scaffolding.  

15. A new Also tie the top lift option has been added for all tie patterns in the Anchors menu.  
This option causes the top lift to be tied at alternate standards in addition to any other ties 
already present.  This option is automatically applied for sheeted independents and 
independents with hop-up brackets, as it is required for TG20:13 compliance. 

16. Double standards can now be applied to attached ladder towers, bridges and attached 
loading bays for Tube and Fitting. 
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17. The following components have been added to the Layher Allround system:  19” wide 
aluminium decks in sizes: 3’10”, 5’2”, 6’, 7’, 8’ and 10’. 

18. For scaffolding systems which support 12-leg stair towers, these can now be created through 
the schedule.  This is done by adding any scaffold and changing the type to “12 Leg Stair 
Tower”. 

19. A bug was fixed which caused the word “Welcome” and a checkbox in the bottom right to 
sometimes be partially off-screen on the welcome screen. 

20. A bug which sometimes caused the Main Lift Height in the schedule to reset to “Varies” 
immediately after changing the value has been corrected. 

21. Tube and Fitting loading bays no longer include plan bracing if suitable wing bracing is 
already present on the same lift. 

22. The tie pattern for Tube and Fitting cantilever fans has been corrected. 

23. Single scaffold items now only generate a single page of drawings, rather than repeating. 

24. PDF site plan files with a capitalised extension will now be imported correctly. 

Version 5.31 (Build 494): July 2014 
The following enhancements have been made in this version of SMART Estimator:   

1. You asked for quotation documents to be prepared for printing more quickly. 

This version of SMART Estimator creates the print preview for a quotation document much 
more quickly than ever before. 

2. SMART Estimator now uses less memory when generating quotation documents. 

Version 5.3 (Build 490): April 2014 
The following enhancements have been made in this version of SMART Estimator:   

1. SMART Estimator now includes tools to allow integration into the Building Information 
Modelling (BIM) process. 

1.1. You can now create Industry Foundation Classes (IFC 2x3) models of your scaffolding, which 
can be used as part of an existing BIM model or exported to Revit, SCIA Engineer or similar. 

 

1.2. It is now possible to import a 2D site plan or building plan from an existing PDF, DXF or 
AutoCAD DWG File. 

1.2.1. The site plan is shown as a background in the 3D model.  You can then use the points of the 
background to create your scaffolds in 3D. 
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1.2.2. You can also move and re-centre your background.   

1.2.3. You can scale the background (using any known elevation length).  

1.2.4. You can even filter the background.  You can show lines of only your selected colours.  Also, 
if the imported file had layers, you can filter the background to show only the layers you 
want to use. 

You must have the SMART Estimator BIM Toolbox module licensed on your hardware key to 
use the BIM Tools features. 

2. Edge protection guard rails are now available in SMART Estimator!  

2.1. These guard rails can be erected using double or triple guard rails. 

2.2. Edge protection guard rails can be created in two styles:   

2.2.1. From the roof top: Here, guard rails are erected separate from any other scaffolding.  They 
are erected at a roof or slab edge to provide fall protection. 

2.2.2. From the ground: Here, guard rails are erected by extending standards from the ground level 
above the roof line.  The standards may be part of an existing independent scaffold. 

2.3. Edge protection scaffolds can be created from within the schedule, 3D model or Draw Plan 
modes. 

2.4. Edge protection can be supported by an independent scaffold.  They can also be erected 
without this support. 

3. The SMART Estimator Enterprise Server has been enhanced with the following tools and 
improvements: 

3.1. SMART Estimator Server Tools 

This separate application is installed whenever the server is installed.  It includes the 
following features: 

3.1.1. Backup & Restore 

You can now backup your server to a single file.  You can restore this file, providing 
protection against server failures. 

3.1.2. Archive 

Keep your server responsive and save space by archiving old projects, which are not 
regularly used.  You can archive all the projects. 

 Before a chosen contract number, or 

 Before a selected date, or 

 Select your own projects to archive. 

4. Server Recycle bin 
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Erased projects on the server are no longer permanently deleted.  Instead, they are moved 
to the server recycle bin.  From the bin, they can be restored or permanently erased. 

5. Follow-Up Reminders 

Every server project can now be given a follow-up date.  On this date, a message is displayed 
to everyone connected to the server, showing that a follow-up call is required. 

6. It is now possible to search through your server projects using the search box at the top of 
the grid.  

7. Server projects can now be grouped into categories (folders). 

8. It is now possible to set up your scaffolding system and store it under your chosen name. 

8.1. You may have more than one scaffolding system configuration per licenced scaffolding 
system.  For example, if you have two locations carrying different scaffolding components, 
each can have their own configuration. 

8.2. Your scaffolding system configuration can be given a unique name.   

8.3. You can set the display name, which is used on the quotation and in the menu for changing 
the scaffolding system. 

8.4. Changing the scaffolding system configuration settings will now update all project items, 
rather than a single one.  For example, changing the available bay sizes for Layher Allround 
will now update all Layher Allround scaffolds in every item in the project. 

9. SMART Estimator has had some major performance and memory improvements.  It now 
uses significantly less memory, particularly for projects with twenty or more project items. 

9.1. Memory improvements only effect projects created using SMART Estimator v5.3. Earlier 
projects will not be affected. 

10. The SMART Estimator quotations have been improved. 

10.1. The following SMARTText is now newly available for any section of a quotation. 

10.1.1. Terms and Conditions 

The terms and conditions SMARTText can be selected to tick a list of conditions.  Each 
condition in the list can be set to appear:  

 Automatically for every new quote, or 

 Never automatically added.   

Conditions can also be recommended so they are easy to find within longer lists. 

11. Start Date 

This date shows when work is expected to commence on the project. 

12. The following SMARTText is now available for item description sections of a quotation. 
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12.1. Clauses  

The clauses SMARTText field works exactly like the Terms and Conditions field above.  
Additionally, you can set clauses to appear only when certain types of scaffold are present in 
the item. 

12.2. Item Usage Description 

This description (sometimes known as a lead-in) can be set from a new column in the 
schedule.  It describes how the project item is going to be used.  For example, this might say 
“access” or “raising brickwork”. 

12.3. Loading Description: Maximum nominal grid 

This SMARTText describes the maximum nominal grid used to erect the scaffolding. 

12.4. Scaffold widths 

This describes the width of scaffolds, including inside boards, toe boards and cantilever (hop-
up) platforms. 

13. Terms and Conditions or Clauses can be imported from SMART Scaffolder UK, if you already 
have this product. 

14. The Scaffold Dimensions SMARTText now shows optional qualifications.  These qualifications 
can be set for any scaffold.  For example: “Build off and partly over roof”. 

15. Where the item will be erected and dismantled progressively can now be set from within the 
schedule.  The settings from the new Progressive Erection and Progressive Dismantle 
columns are now used to create the Progressive Description SMARTText. 

16. Whether items will be adapted can now be set from the schedule.  Use the Adaption 
description and Re-adaption description columns to control the text which is shown in the 
Adaption Description SMARTText. 

17. The Decking Description SMARTText has been improved.  It now includes: 

17.1. The decking or boards material / type; 

17.2. How many lifts are boarded; 

17.3. A description of how the boards will be moved progressively. 

17.4. The Access Description, which describes ladder and stair access, has been improved.  It now 
gives more details about access, such as: 

17.4.1. The number of ladders present and which lift they begin at; 

17.4.2. The number of ladder towers present and a ladder description for each; 

17.4.3. The number of stair towers present, grouped by their height. 

18. The Guard Rails Description has been improved to better describe the scaffolding’s guard 
rails.   
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19. The Add-ons Description is now much more detailed.  It lists many add-ons, such as bridges 
and brick guards, to include more detail about their location and sizes. 

20. The Loading description has been improved.  In most cases it is much shorter, using 
improved logic to group scaffolds with the same loading. 

21. When a single scaffold is present, it will no longer be given a special name by default.  The 
first independent in an item is always called “Independent 1”, for example not 
“Independent”.  This makes items with less scaffolding appear more consistently in the 
quotation.  You can still set the scaffold name yourself, as before. 

22. It is now possible to create a cantilever protection fan which protects only a section of the 
elevation, by setting the Start and End positions of the fan. 

23. The SMART Estimator Modelling has been enhanced: 

23.1. The following improvements apply to all scaffolding systems: 

23.1.1. To help you create even better 3D visuals, it is now possible to create elevations which have 
no scaffolding.  These elevations only appear in the 3D model.  They are not shown in the 
quotation, pricing reports, etc.  

24. Bridges have been improved 

You can now choose which bay you wish to place a bridge in more easily, by selecting it 
when the bridge is first placed.   

A single un-split elevation of independent scaffold can now hold more than one bridge. 

Bridges no longer have to extend all the way to ground level.  They can be lifted so they 
begin above any number of lifts. 

25. Birdcages have been updated 

Birdcages can now be perimeter boarded: Only the outer bays of a lift are boarded.  When 
adding boards to a lift, add them once to get perimeter boards and twice to fully board the 
lift.  When erasing, you must now erase twice to remove all of the decking from a lift. 

Birdcages can now include elevations, which they will automatically butt against. 

26. Attached ladder towers have been improved 

Attached ladder towers can now be extended so they are multiple bays long. Just drag the 
end to make your ladder tower longer. Extended ladder towers share façade and ledger 
bracing. 

Inside guard rails can be added to, or removed from any bay of an attached ladder tower, 
giving you control of how the tower is accessed. 

27. Double sole boards and double sole pads are now available. 

Just apply the Boards tools to the base plates twice to add double sole boards. 
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28. Unit beams are now 605mm deep. 

29. Ladder beams have been visually improved in the 3D model. 

30. The following improvements are only available for Tube and Fitting: UK scaffolds: 

30.1. Bridges have been improved 

In compliance with TG20:13, bridges now use existing bays as supports.  They no longer 
require additional shorter ‘tower’ bays. 

The lacing and bracing for bridges has been updated to conform with TG20:13.  Scaffolds 
with bridges now require less bracing, as the façade and ledger bracing for the bridge is also 
considered to reinforce the scaffold it is attached to. 

Additional beams are now added above existing bridges for very tall independent scaffolds, 
in compliance with TG20:13. 

Double standards and sole boards are automatically added for bridges on very tall 
independents and birdcages as required by TG20:13.  These can be removed with the eraser 
as usual. 

31. Loading bays have been updated. 

The loading bay which appears in the Special scaffolds section (requiring structural 
calculations) of TG20:08 is no longer used by SMART Estimator.  Instead, the TG20:13 style 
of loading bays are available.   

These loading bays: 

31.1. Are available in 3 sizes: 2 x 2m bays, 2 x 1.8m bays, or 2 x 1.5m bays; 

31.2. Show a new style of loading bay gate; 

31.3. Include double sole boards by default; 

31.4. Include brick guards at the top lift; 

31.5. Are tied at both end standards; 

31.6. Include underslung structural transoms at every node position. 

32. Birdcages have been updated. 

Birdcages now use the new Continuous Bracing pattern as shown in the TG20:13 eGuide, by 
default. 

33. Façade bracing has been updated. 

Single Bay bracing, as recommended in TG20:13, is now the new default.  

Façade bracing can now be moved!  You can drag columns of bracing to get the bracing you 
desire.  Bracing will be added automatically if it is required to comply with TG20:08 or 
TG20:13. 
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You can reset to the default bracing by applying the tool from the Bracing dropdown again. 

The logic for placing façade bracing has been improved.  Bracing is now placed so that a 
single continuous tower is created wherever possible, especially when gables, slopes or 
steps in the ground are present. 

The horizontal tube which acts as a single guard rail at ground level, can now be erased using 
the Ctrl key. 

34. Free-standing ladder towers and buttresses have been improved. 

Free-standing ladder towers can now be extended so they are multiple bays wide.  For this 
reason, the Double bay ladder tower and Double bay buttress options have been removed. 

The sole boards, default width and bracing of free-standing ladder towers has been updated 
with reference to TG20:13. 

35. Inside (hop-up) platforms now have extra toe boards and guard rails in some cases, as 
described in TG20:13. 

36. Cantilever protection fans are now 6 boards wide by default.  They are supported by tubes 
from below where possible, and now use fewer components, as described in TG20:13. 

37. Façade bracing, ledger bracing, transom, ledger and guard rail heights and overlaps have 
been improved to match the description in TG20:08 and TG20:13. 

38. Double standards are now placed one board width apart.  They no longer require parallel 
couplers, as shown in TG20:13. 

39. The tie patterns have been improved to match the TG20:13 description when a pavement lift 
is present.  This continues to comply with TG20:08. 

40. The following improvements are only available for Layher Allround scaffolds: 

40.1. Californian guard rails 

These guard rails, once activated from the Configuration, raise the guard rail height.  They 
are used to comply with some OSHA or state regulations. 

40.2. Bridge beams 

Layher bridges will now appear in-line with the connection positions, rather than below. 

40.3. Triple guard rails 

It is now possible to apply triple guard rails to boarded lifts, or to the top lift only. 

40.4. Public access handrails 

Layher 10-leg stairs can now be given public access handrails, which have closely set bars, 
better suited for public access stairs. 

41. The following improvements are only available for Kwikstage: UK scaffolds: 
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41.1. Single Bay (Alternating) bracing is now available. 

This alternating bracing is only recommended for shorter scaffolds. 

42. The SMART Estimator pricing reports have been improved: 

42.1. You can now set the address of your depot (yard). 

42.2. It is now possible to calculate the transport distance in kilometres, miles or hours, using 
Google maps automatic calculations. 

42.3. Transport can now be priced using new methods: 

42.3.1. Miles or kilometres; 

42.3.2. Tonnes or tons per mile, km or hour; 

42.3.3. Hours per mile or km. 

42.4. Circular tanks no longer share pricing rates with independent scaffolding.  They can now be 
set to automatically use a different pricing method and rate. 

42.5. The Extra Hire figure is now always shown, even when the Materials section is hidden.  

43. The Configuration pricing view now shows more decimal places, even when a price is not 
highlighted. 

44. It is now possible to import your pricing methodology and rates from SMART Scaffolder UK, 
if you have this product. 

45. The SMART Estimator address book has been enhanced: 

45.1. Whenever a project is newly created through the File menu or welcome screen, you are 
prompted to provide a customer and site address before continuing. 

45.1.1. The customer address can be viewed and updated from within the quotation. 

45.1.2. The site address can be viewed and updated from within the quotation or item pricing 
report. 

45.1.3. The site postcode is automatically applied to the TG20 wind calculations. 

45.2. Addresses can now be set into Groups.  A Group of addresses might include all of the 
addresses for the branches of a company, or a certain type of address. 

45.2.1. An addresses’ Group does not appear in the quotation. 

45.2.2. You can use new arrow buttons to quickly switch between addresses in a Group. 

46. Scheduling Improvements: 

46.1. The schedule has now been organised into two views: 
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46.1.1. Summary View 

This view shows columns which apply to the item as a whole.  It is shown automatically 
when a new project item is created from the schedule. 

46.1.2. Scaffolds View 

This view shows columns which can be different for each scaffold.  It is shown automatically 
when a new scaffold is created. 

46.2. Scaffolding systems which you do not have a licence for will no longer appear as options in 
the Scaffolding System column. 

47. It is now possible to set a loading through the Check IT tab for each decked lift of: 
independents, birdcages, circular tank scaffolds, ladder towers, loading bays. 

48. The CADS Hardware Key Update utility, which is installed with SMART Estimator has been 
improved: 

48.1. Each licence now includes an information (i) icon.  Clicking on it shows the hardware key’s 
unique serial number. 

48.2. Network licences are now shown as red, while other licences are shown as green. 

48.3. Licences which you have are now shown first in the list.  Unlicensed modules are shown last. 

49. The menus for saving and deleting your quotation templates, pricing rates and scaffolding 
system configurations will now highlight the item you are currently changing. 

50. Drilled anchor ties now require one less double coupler.  

51. It is now possible to install the SMART Estimator Enterprise Server and SMART Estimator on 
the same computer in a single installation. You will still need the SMART Estimator 
Enterprise licence to connect to the server.  

52. While SMART Estimator is loading, it now provides more detail about what it is doing.  It is 
now possible to hide the loading panel, while you wait for SMART Estimator to launch. 

Version 5.21 (Build 464): November 2013 
The following enhancements have been made in this version of SMART Estimator: 

1. SMART Estimator and the SMART Estimator Enterprise Server will now install and run under 
Windows 8.1 (32-bit and 64-bit).     

2. The SMART Estimator Enterprise Server will now install and run under Windows Server 2012 
R2 (64-bit). 

3. The following components have been added to the Kwikstage: UK system:  Components for 
bay sizes: 3.2m, 1.27m, 1.5m 2.0m, 2.5m and 3.0m and components for bay widths: 0.7m 
and 0.76m (2’6”). 
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Version 5.2 (Build 460): September 2013 
The following enhancements have been made in this version of SMART Estimator: 

1. SMART Estimator now does more to help standardise your quotation and pricing 
methodology.  You can share a single address book, your quotation templates, pricing rates 
and material configurations across a network using the new SMART Estimator Enterprise 
Server. 

From the File menu, you can track, view and edit projects saved to the Enterprise server. 

You must have the Enterprise module licensed on your hardware key to use this feature. 

2. You can now license all of your SMART Estimator users with a single license!  You can keep 
this license locked away safely in the server room. 

3. SMART Estimator now includes a full screen option, making it easier to use on a tablet, such 
as the Microsoft Surface Pro, or on a smaller screen. 

4. Contract Numbers are now automatically assigned, so every project can be identified.   

This contract number can be formatted to suit your business.  If you have the network 
version, all projects saved on the server will have a unique contract number.  You can even 
use the optional prefix and suffix to identify who created a quotation and when.  You can set 
the prefix, suffix and how many digits you want to use from the Settings screen in the File 
menu.   

5. A new full screen File menu has been added.  If you have the network version, SMART 
Estimator now includes an optional welcome screen to help you get started.   

6. You can now track your projects by setting their Status: Won / Lost / In Progress or Quoted. 

7. Share quotation templates more easily by importing and exporting them. 

8. Enhance your quotations with a signature graphic. 

9. A My Job Title SMARTText field has been added to the quotations. 

10. Components for the following bay sizes have been added to the Layher Allround system:  
10’, 5’4”, 1m, 1.5m and 2m.   

11. The following components have been added to the Kwikstage: UK system:  A 4.88m (16’) 
bowstring birdcage transom, Standards (legs) sized 1m, 1.5m, 2m;  components for bay sizes: 
2’6”(0.76m), 1.3m, 1.5m, 2m, 2.5m, 3m, 3.2m; components for scaffold widths: 0.5m, 0.6m, 
0.7m, 2’62(0.76m), 1.5m, 2m, 2.5m. 

12. A new HAKI guard rail post has been added, which is used when creating openings on a HAKI 
stair tower. 

13. Gravlock couplers (used to suspend scaffolds from beams) can now be manually added to 
any material list.  These must be selected from the Configuration. 

14. The operating systems that SMART Estimator works with have changed for this version: 
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14.1. Microsoft Windows XP is no longer a supported operating system.  This version  will not 
install on a Microsoft Windows XP workstation. 

14.2. SMART Estimator version 5.2 supports the following operating systems: 

 
SMART Estimator Enterprise Server SMART Estimator 

Windows 8 Windows 8 

Windows 7 (with Service Pack 1) Windows 7 (with Service Pack 1)  

Windows Vista (with Service Pack 2) Windows Vista (with Service Pack 2) 

Windows Server 2008 R2 (with Service Pack 1)  

Windows Server 2012  

Version 5.1 (Build 435): May 2013 
The following enhancements have been made in this version of SMART Estimator: 

1.  A 10-leg stair is now available for the Layher Allround system.  

2. The Kwikstage 12-leg stair can now be built using a wider (stretcher) stair unit. 

3. It is now possible to show the material list for a range of heights or lifts, or for a single 
elevation.  This feature is available through the Material List Print Preview. 

4. Loading Bays may now have more than one decked lift. 

5. Foot lifts can now be decked. 

6. Stairs may now be raised so they start from a higher standard connection. 

7. Buttress has been corrected so they use fewer components. 

8. Every component can now be assigned a Labour Time value (in minutes) through the 
Configuration.  The new Component minutes method can be used to price a scaffold based 
on the amount of labour time required for each component. 

9. Tie tubes can now be set attach to either just the outer standard; or to the inner and outer 
standards.  

10. A special pricing line has been added for structural lifts.  Lifts which are not decked can be 
set as structural or un-boarded. 

11. Buttons have been added to Scheduling for copying and pasting scaffolds.  

12. Sliding brackets (which hook on to the ledgers) have been added to the Layher Allround 
system. 

13. These are used for cantilever platforms, to allow infill bays to be decked. 
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14. The labour for fixing beams, rubbish chutes, debris netting and sheeting can now be priced 
in imperial or metric units. 

15. The Change Scaffolding System menu has been added to the editable material list. 

16. The shortcut keys for adding a new blank project item (Ctrl + Insert) now appear in the 
Project Browser. 

17. Some tools could only be applied previously by clicking on the standards.  This has been 
improved so that many tools can now be applied by clicking anywhere on the scaffold.  

18. Address contact titles, forenames and surnames can now be set without opening the 
address book, by clicking on the address in the quotation. 

19. The following components have been added to Layher Allround:  components for 8’, 7’4” 
and 3’10” (1.15m) bays; stair components and robust ladder access decks for 2.5m and 3m 
bays; corner decking up to 1.3m; 9.5” width timber and aluminium decking for imperial 
length bays. 

20. The following components have been added to Kwikstage: UK:  1.83m (6’) and 2.44m (8’) 
transoms; 0.81m timber deck; 

21. Plastic caps (armadillos) have been added to the configuration.  These can be added to the 
material list in the Extra Materials section. 

22. To improve the layout, the word “Erect” has been removed from scaffold lines in the Cost 
Analysis “ERECT” section. 

23. A single scaffold will no longer appear as “Scaffold” in Cost Analysis.  Instead, the scaffold’s 
name will be used. 

24. The Change Scaffold Direction button, used to make independents swap to the other side of 
an elevation, is now a tool which can be dropped on a scaffold. 

25. Kwikstage buttress and loading bay ledger bracing has been corrected. 

26. Kwikstage loading bays are no longer plan braced by default, unless a wing brace is 
removed. 

27. The Cuplok: UK façade bracing pattern has been corrected. 

Version 5.0 (Build 410): March 2013 
The following enhancements have been made in this version of SMART Estimator: 

1. This version of SMART Estimator includes integrated quotations.  

Use the quotations provided to quickly print a letter to send to the customer, or design your 
own with easy-to-use tools. 

Create one-off documents or save them to My Quotes to use again and again. 
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SMARTText lets you add words or phrases to the quotation which change as you make 
changes to the contract.  

2. A new item pricing report has been added.  

This flexible pricing report allows you to automatically calculate a price for every item in the 
contract.   

This report is highly customisable, so you can price your scaffolding the way you want to.  All 
of your preferred settings can be saved.  You can also export them and send them to a 
colleague.  It is possible to create multiple different pricing methods and change between 
them easily if you prefer. 

3. There is a new project pricing report available in this version of SMART Estimator.  

This report summarises the pricing for the entire contract.  It is easy to quickly change the 
pricing for any item from here, or for all items at once. 

4. This version of SMART Estimator also includes a new scheduling report. 

The scheduling report can be used to quickly create even large, multi-scaffold contracts.  
Scaffolds and contract items can be added to the project with a few key presses.  Editing 
with just the keyboard is equally easy. 

A new type of scaffold has also been added which is only available through this report: 
Manual scaffolds.  A manual scaffold is not modelled in 3D, but you can use it to create a 
customised scaffold with the exact materials that you require. 

You can also use this module to copy and paste scaffolds within a single item, or between 
items. 

5. It is now possible to edit the material list.  

Opening the material list now shows an editable report.  You can change the quantities and 
types of materials used, as well as changing the weights.  

You can use this feature to add or remove materials from a scaffold.  It can also be used to 
create materials on an otherwise blank item, or to set the materials for a manual scaffold. 

There are two parts to the editable material list.  In the summary section, you can adjust the 
materials which were automatically calculated for your scaffold.  It the extra materials 
section, you can add new materials which will be used even if the scaffold changes. 

It is possible to view and change the material list for each scaffold as well as for the whole 
item. 

6. The button layout has been streamlined for ease of use.  In most cases, buttons which you 
do not have licensed on you hardware key will be hidden. 

The buttons have been grouped depending on what they are for.  For example, all of the 3D 
modelling buttons are now available on the Modelling tab. 
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Buttons with related functions have been grouped together.  For example, the button for 
setting the image to be used on scaffold banners is now grouped with the button for adding 
a banner to the model. 

7. It is now possible to rename scaffolding components. 

In the configuration, you can now change the names which are used for components in the 
material list.  This means that if you want to call the “Steel tube: 14’” component “14 foot 
tube” you can change it.   

8. It is now possible to change the weight of any component in the configuration. 

9. It is now possible to edit the product code for any component in the configuration. 

10. A 4-leg stair is now available for Kwikstage.  

11. Canadian and US-style vertical ladders are now available for all systems.  These ladders can 
be placed on the end of a scaffold run, or on the outside face. 

12. A free-standing loading bay has been added for estimation purposes only. 

13. There is a new option available for scaffold run corners in Setting Out View.  You can use the 
constrain in both directions option to restrict a corner bay in both directions.  In most cases 
this will create a square bay in the corner. 

14. It is now possible to change the display name for a system in Modelling.  The display name is 
used in the Change Scaffolding System menu and in the quotation. 

15. Circular tanks may now be smaller than 3m in diameter.  For internal scaffolds, the 
scaffolding will disappear if the tank is too small to accommodate it. 

16. Wing bracing is now added by default to most attached scaffolds.  It can be erased with the 
eraser (or from a single lift by pressing the Ctrl key when erasing). 

Wing bracing can also be added to an attached scaffold by using the tool on the Bracing 
menu. 

17. There is a new ledger bracing option available from the Bracing dropdown for Cuplok: UK 
scaffolds.  Cuplok: UK scaffolds still do not use ledger bracing by default. 

18. Ledger bracing can now be erased from a single elevation using the Ctrl key and the eraser.  
Ledger bracing can now be erased from all elevations using the Shift key with the eraser. 

19. You can now specify that toe boards will not be used in your scaffold.  It is recommended 
that toe boards are provided in most cases, but this option is provided for estimating 
purposes. 

20. It is now possible to set the colour of the main tubular components for a scaffolding system.  
The available options are: 

 Galvanised Steel 
 Painted Yellow 
 Red 
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 Dark Red 
 Green 
 Blue 

21. Cantilever platforms can now be lifted up to 1m above the lift as well as below the lift, or 
0.5m for the top lift. 

22. The Kwikstage loading bay is no longer façade braced. 

23. Various Layher Allround components have been added for bays sizes: 4m, 3m, 2.5m, 2m, 
1.5m, 1.25m, 1.065m, 1m, 0.75m (2’5”), 2’2”, 0.5m,   2’ – 9’. 

24.  A Kwikstage 2’8” (0.81m) steelstage deck and ledger have been added. 

25. A 5m timber board has been added. 

26. When you apply a watermark, it will now be remembered and used for future jobs 
automatically. 

27. When you apply a toe board material or deck material, this setting will be saved and used for 
future jobs. 

28. Different colours of sheeting and debris netting can now be mixed on the same scaffold. 

29. The gallery of skins, which change the look and feel of the software, has been moved to the 
Help tab. 

30. A warning message now appears before erasing a scaffold with the eraser in Modelling. 

31. Tube and Fitting buttress ledger bracing now faces upside towards the main scaffold. 

32. Elevation numbers are now drawn last, so they are not hidden by scaffolding on top of them. 

33. There is a new ‘Not Loaded’ option available from the Check IT Loading dropdown. 

34. The Form-scaff Kwikstage ladder hatch has been corrected.  

35. An error with the drawings for scaffolds which have been rotated has been corrected. 

Version 4.11 (Build 369): February 2013 
The following enhancements have been made in this version of SMART Estimator Modelling: 

1. The software will now install and run under Windows 8 (32-bit and 64-bit). 

Version 4.1 (Build 368): August 2012 
The following enhancements have been made in this version of SMART Estimator: 

1. Enhanced modelling: Multiple Scaffolds is now available in Modelling. 
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It is now possible to create several scaffolds next to each other.  Now you can model several 
separate scaffolds.  Depending on the modules that you have licensed, you can:   

 Create a 3D model and image for multiple scaffolds. 

 Get a quick list of quantities required for multiple scaffolds. 

 Get a single material list for multiple scaffolds 

 Get a single set of drawings for multiple scaffolds. 

You can use this great new feature to estimate complicated scaffolds more easily. 

You can also use it to group scaffolds together. 

2. Loading bays, Ladder towers and Simple buttresses are now available in Modelling. 

Ladder Towers 

Ladder towers can be created as standalone scaffolds, or attached to independents.  If you 
attach two ladder towers next to each other, they will stick together:  The guard rails and 
bracing between them is removed to create one continuous platform. 

Simple Buttresses 

Single bay buttresses can be added to independent as extra support. 

Loading Bays 

Every system except for Frame Scaffolding now has loading bays available.  Cuplok and HAKI 
Universal loading bays are knee braced, while other systems use beams to support the 
boarded lift. 

3. The Frame Scaffolding system is now available in Modelling. 

Based on the Superior Frame system, this new system can be used to model independent, 
birdcage, circular tank, or standalone staircase scaffolds. 

Walkthru or Standard frames can be used for each lift.  Cross-bracing or guard rail panels can 
be used at each lift, inside and outside.  Guard rails will automatically be added to cross-
bracing, to meet the OSHA guidelines.  Vertical ladders can be added to a scaffold.   

Depending on the modules that you have licensed, you can use the Frame Scaffold system to 
create a list of components and drawings, or export the drawings to PDF or AutoCAD DXF. 

4. The HAKI Universal staircase is now available for Tube and Fitting scaffolds in Modelling. 

If you have Tube and Fitting licensed, the HAKI Universal staircase is now available, to be 
attached to Tube and Fitting independent scaffolds. 

5. The US English language is now available in Modelling. 

The language can now be switch to US English from the File menu. 
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6. Models and reports can now be viewed using Imperial Measurements! 

Tired of having to use metric measurements for entering the size of your elevations?  Want 
to see your material list report in pounds instead of kilograms?  Switch to Imperial 
Measurements from the File Menu, and now you can! 

Metric measurements will continue to be supported as well. 

7. You can now add a watermark to reports! 

The watermark feature is now available for the material list and drawings.  Enhance your 
reports by adding a watermark for more professional, smarter documents. 

8. Scaffolds which fail TG20:08 will now produce a report saying why they have failed.  
Previously this report was only available for Tube and Fitting independent scaffolds. 

9. Many staircases, ladder towers, loading bays and buttresses can now be attached to a single 
elevation.   

There is no need to split an elevation in order to place one of these add-ons.  You can also 
choose exactly which bay you would like the staircase to be added to, instead of dragging it 
in to position. 

10. You can now hide the ground, using the new ground options on the Options tab. 

11. The minimum distance between circular tank towers can now be controlled through Setting-
Out View, giving you more control over the bays used. 

12. You can now move scaffolds using the new Move Scaffold button in draw plan, or on the Edit 
Scaffold tab. 

13. Scaffolds can now be renamed. 

14. Scaffolds can be rotated so that they face in the desired direction. 

15. Draw Plan can now be accessed without deleting all of the scaffolds in the item.  This allows 
you to add more scaffolds, or move them around. 

16. The guard rails used on the top lift can now be different from other lifts, using the new Top 
Lift Only tool on the Guard rails dropdown menu. 

17. You can now hide scaffolds, so that it is easier to see what you are doing. 

18. The default HAKI Universal prices and weights have been updated. 

Note you will only see this effect after you install (or re-install) Modelling and the HAKI 
Universal system is already licensed. 

19. Ladder beams have been added in the following sizes: 11’, 16’, 21’. 

20. The Form-scaff Kwikstage 900mm width stair unit has been added.  When the 900mm stair 
unit is configured, just drag the staircase out sideways to change its width. 
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21. HAKI Universal standards have been fixed.  They are now correctly removed for most 90 
degree corners. 

22. HAKI Universal staircases have been fixed so that you ascend the staircase clockwise. 

23. Layher Allround standards without spigots will now be used correctly. 

24. Kwikstage return transoms in the foot lift have been fixed for independents on flat ground. 

25. Layher Allround part boarded lifts now use the correct transoms. 

26. A 4’2” ledger has been added to the Kwikstage system. 

27. Layher Allround components have been added for bays size 2’ – 9’. 

28. Layher Allround ledgers have been added sized 0.5 – 3m. 
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Version 4.0 (Build 327): April 2012 
The following enhancements have been made in this version of SMART Estimator: 

1. Circular tank scaffolds are now available in Modelling. 

It is now incredibly fast and simple to create a scaffold around a circular tank.  Just grab and 
drag the tank to resize it, and the scaffold is created automatically.   

All of the add-ons and attachable staircases available for independent scaffolds are also 
available for circular tanks. 

2. The HAKI Universal scaffolding system is now available within Modelling. 

HAKI Universal can be used to create independent, birdcage, standalone staircase or circular 
tank scaffolds.  Toe boards can be made using Steel or Timber.  Decking can be created from 
Steel, Timber or Lite Deks. 

Depending on the modules that you have licensed you can print a HAKI Universal material 
list and drawings, or export drawings to PDF or AutoCAD DXF. 

3. The Material Configuration has been organised into categories, to make it quicker and easier 
to navigate. 

4. The Material Configuration also has a “Reset to Factory Settings” button.   

This is for when you are not happy with the changes you have made, or you have forgotten 
what you changed.  Simply press the “Reset to Factory Settings” button and all of your 
components and component prices will return to the way they were when Modelling was 
first installed. 

5. The “Cuplok inside board transom: 1.895m” has been added to the Cuplok: UK material 
catalogue. 

6. Form-Scaff now uses ledger bracing in every second bay. 

7. Form-Scaff ladders have been improved.  They can now be placed on either side of a 
transom, or attached to the top guard rail at the end of a scaffold run. 

8. Cantilever fans will now be carried through to an exported DXF file. 
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Version 3.3 (Build 294): January 2012 
The following enhancements have been made in this version of SMART Estimator: 

1. The Layher Allround scaffolding system is now available within Modelling. 

Layher Allround scaffolding can be used to build independent or birdcage scaffolding, or 
standalone staircases. Decking may be built from Steel, Timber, Stalu or Robust decks.  
Access hatch decks can be chosen from Aluminium or Robust as well as the 4 legged 
staircase.  Further options are available to remove ledgers from decked bays, or change the 
infill material, making this a truly flexible system. 

Depending on the modules that you have licensed you can print a Layher Allround material 
list and drawings, or export drawings to PDF or AutoCAD DXF. 

2. Gables may now be adjusted horizontally as well as vertically, allowing much greater 
flexibility in the type of scaffolds that can be modelled. 

3. Van Thiel components have been added to the Tube and Fitting catalogue. 

3.1. Thiel-Lock system transoms, including extendable transoms, can now be used in place of 
tube-and-fitting transoms or Readylok transoms.  They can be displayed in the 3D view, 
included in the drawings and material list, and exported to AutoCAD via the Drawing Link.  

3.2. Various Van Thiel couplers have been added to the Tube and Fitting catalogue. 

4. Saved Modelling files are now automatically compressed, allowing even large projects to be 
attached to emails. 

5. Placing an access hatch deck for the Cuplok NL system now causes the foot lift to become 
boarded. 

6. A one foot long tube has been added to the Tube and Fitting catalogue. 

7. The placement of façade bracing has been improved to make it more efficient across split 
elevations. 
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Version 3.2 (Build 267): October 2011 
The following enhancements have been made in this version of SMART Estimator: 

1. You can now create and organise several items of scaffolding with the new project browser: 

1.1. You can create projects with combinations of different scaffolding structures and even use 
several scaffolding systems within the same project, depending on which scaffolding systems 
you have licensed; 

1.2. You can enter a contract number, a description of the project and a description of each item 
that will be included in the headers of your drawings, material lists and TG20 checks. 

1.3. Scaffolding items can be copied to allow you to quickly model similar structures. 

1.4. You can select which items to include when you print your drawings, material lists and TG20 
check reports. If you include more than one item in your printed material list you can print 
the total quantities plus the breakdown of quantities for each item. 

2. The export of the drawings to the Adobe PDF electronic format has been greatly improved. 
The resulting PDF documents load and print more quickly and to a higher quality, while the 
file size is greatly reduced to make them easier to send by email. 

3. The Setting-Out View for system scaffolding now shows the return direction at corners with 
graphical arrows that can be clicked to easily change the priority of fly-pasts. 

4. The setting-out of the Kwikstage system has been improved to build rectangular bays in the 
corners by default. The positioning of tube-and-fitting in-fills has also been improved to 
avoid building them adjacent to returns where possible. 

5. The 12-legged Kwikstage staircase has been improved to include additional ledgers and 
façade bracing. 

6. The setting-out of system scaffolding has been improved to use fewer bays in cases where a 
tube-and-fitting in-fill is required. 

7. Ladders are now automatically removed from an elevation when placing a staircase. 

8. The layout of Cuplok façade bracing has been improved to avoid the end bays, where 
possible, following the guidance from the Cuplok user guide. 

9. The AutoCAD DXF drawings have been improved to include the toe boards in the side views 
and to improve the positioning of some of the scaffolding components. 

10. Tube-and-fitting safety gates have been updated to use fewer tubes and couplers. 

11. The Form-Scaff scaffolding system has been provided for use in South Africa. Please contact 
CADS if you would like to purchase this system and activate it on your hardware key. 

12. A bespoke engineering check developed for Lyndon Scaffolding has been included. 
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Version 3.1 (Build 241): July 2011 
The following enhancements have been made in this version of SMART Estimator: 

1. The Kwikstage scaffolding system is now available within Modelling. 

Kwikstage scaffolding can be used to build independent or birdcage scaffolding. Options are 
available to build with continuous or single-bay façade bracing, with steel or timber battens, 
using guard rails or Kwikguard frames. 

Depending on the modules that you have licensed you can print a Kwikstage material list 
and drawings, or export drawings to PDF or AutoCAD DXF. 

2. The Cuplok Omega system has now been added, allowing you to use modular decks and 
hop-up platforms with Cuplok scaffolding. 

3. New system staircases have been provided for Cuplok and Kwikstage scaffolding: you can 
now build a Cuplok staircase with 8 or 10 legs or a Kwikstage scaffold with 8 or 12 legs. You 
must have the Cuplok UK or Kwikstage UK modules licensed on your hardware key to use 
these features. 

4. Ladder hatches are now shown in the 3D model, drawings and material list. If you do not use 
ladder hatches you can deselect them from the material configuration. 

5. The tubes selected for the material list and drawings have been improved for tube-and-
fitting scaffolding to use shorter lengths where possible. 

6. Ladder landings have now been improved to allow you to build within a single bay, if it is 
longer than 2.4m, or across two shorter bays. 

7. Cantilever fans are now shown in the drawings and their representation in the 3D model has 
been improved to show the extension of the supporting tubes to the inner standards. 

8. The Cuplok deck adaptor component is now available, allowing you to build a Cuplok 
birdcage without standards protruding through the deck. The latest Cuplok components 
from the Harsco catalogue have also been added, including new steel toe boards and 
standards without top spigots. 

9. A new option has been provided to display a brickwork pattern on the building façade. 

10. Corner fillers are now provided for system scaffolding, where available, to fill the gaps left by 
cantilever platforms at internal returns. 

11. The Dutch Cuplok scaffolding system has been improved to add the single-board extension 
bracket, to improve the display of the consoles in the 3D model and drawings, and to add 
the ladder-access transom component. 
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Version 3.0 (Build 209): April 2011 
The following enhancements have been made in this version of SMART Estimator: 

1. This version of Modelling now includes an integrated TG20 check, which checks your 
scaffold for TG20 compliance automatically as you model! To use this feature you must have 
either the Check IT or Check IT plus module licensed on your hardware key. 

1.1. A TG20 compliance report can be printed at any time to prove whether or not your scaffold 
is TG20 compliant and therefore exempt from requiring a structural design. If your scaffold is 
not compliant the report explains why, so that you can amend the scaffold to comply if 
required. 

1.2. A built-in TG20 wind calculator has been provided, so that you can determine the wind 
speed at your site location. This affects the TG20 maximum safe height and required tie 
duty, especially for sheeted or debris-netted scaffolds. 

1.3. A postcode lookup is also available – just type in the site postcode and the wind speed will 
automatically be looked up. 

1.4. The TG20 Appendix H requirements for scaffolds tied to open structures are supported: 
select the Permeable Façade option to check whether your scaffold will be safe if it is tied to 
an open structure or one with a high percentage of openings. 

1.5. Any combinations of loaded lifts are supported, including fully-loaded scaffolds and scaffolds 
with fully-loaded inside boards. 

1.6. The transom spacing is automatically determined from the TG20 loading rules. 

2. Readylok system transoms, including extendable transoms, can now be used in place of 
tube-and-fitting transoms. Readylok transoms can be displayed in the 3D view, included in 
the drawings and material list, and exported to AutoCAD via the Drawing Link. 

3. The placement of façade bracing for tube-and-fitting scaffolding has been improved to 
minimise the bracing requirements while still complying with TG20. 

4. The placement of internal ladders and external ladders has been improved. 

Version 2.2 (Build 160): November 2010 
The following enhancements have been made in this version of SMART Estimator: 

1. Professional drawings and accurate material lists are now available for tube-and-fitting 
scaffolding, as well as for Cuplok scaffolding: 

1.1. Drawings and material lists are available for independent and birdcage scaffolding. 

1.2. Please note that you need to activate this feature on your hardware key unless you already 
own the SMART Estimator base licence, in which case the drawings and material lists will be 
activated automatically. 
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1.3. The materials used to build the scaffold can be configured, allowing you to use only the tube 
lengths, board lengths, fittings, and add-ons that you have in stock. 

1.4. Metric and Imperial tube and board lengths are available. 

2. The supported features for tube-and-fitting independent scaffold drawings include: 

2.1. Dimensioned plan drawings can be created, including scaffolds with non-rectangular returns. 

2.2. Dimensioned elevation drawings can be created, including complicated elevations with 
changes in height, sloping or stepped ground, and any number of gable ends. 

2.3. The plan drawings act as a numbered key plan for the elevation drawings. 

2.4. Bridges can be drawn, with or without a unit or ladder beam. 

2.5. Tie positions are drawn, which can be selected from the standard TG20 patterns. 

2.6. Inside boards, hop-up bracket platforms, and single-stage cantilever platforms are included 
in the plan and elevation drawings. 

2.7. Sheeting, debris netting, and brick guards are drawn. 

2.8. Cuplok system staircases attached to tube-and-fitting scaffolds are included in the plan and 
elevation drawings. 

3. The supported features for tube-and-fitting birdcage scaffold drawings include: 

3.1. Dimensioned plan, elevation, and side-view drawings that include sloping ground, bridges, 
sheeting, debris netting, hop-up bracket platforms, and single-stage cantilever platforms. 

4. All Modelling drawings can be exported to AutoCAD DXF files so that they may be modified 
or arranged professionally on large drawing sheets. 

4.1. Please note that you need the Drawing Link module activated on your hardware key to 
export drawings to AutoCAD. 

5. The modelling of hop-up bracket platforms and single-stage cantilevers has been improved: 

5.1. The 3D representation of the building facade now steps in and out around cantilever 
platforms and inside boards that span part of the elevation, allowing recesses and bay 
windows to be modelled. 

5.2. Hop-up platforms and single-stage cantilevers have been improved for tube-and-fitting 
scaffolding to make them consistent with system scaffolding, including improved inner guard 
rails. 

5.3. The spacing of hop-up brackets can now be modified for platforms around tube-and-fitting 
birdcage scaffolding as well as for independent scaffolding, introducing extra standards 
around the perimeter. 

6. Drawings and material lists can now be exported to high-quality Adobe PDF documents and 
Microsoft Word documents that can be emailed. 

7. It is now possible to erase any single ladder using the CTRL key, making it possible to define 
more realistic ladder layouts and to use combinations of staircases and ladders. 

8. It is now possible to add your company banner to a birdcage. 

9. The Setting Out View for system scaffolding has been improved: 

9.1. The SHIFT key can now be used to set the length of multiple bays at the same time. 

9.2. The gap between the scaffold and facade can be set from the Setting-Out View. 
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Version 2.1 (Build 131): August 2010 
The following enhancements have been made in this version of SMART Estimator: 

1. Birdcage scaffolding can now be modelled: 

1.1. Birdcages can be built with either tube-and-fitting scaffolding or Cuplok scaffolding. 

1.2. Material lists and drawings are available for Cuplok birdcage scaffolding. 

1.3. Birdcages that are rectangular on plan are supported, with one step or slope at the ground 
level. 

1.4. Birdcages can be built with platforms that are either fully-boarded, non-boarded, or have a 
ladder landing. The platforms can be built from timber (for tube-and-fitting and UK Cuplok 
scaffolding) or from timber, steel, or aluminium (for Dutch Cuplok scaffolding). 

1.5. A birdcage can be built with or without edge protection on each side: either using guard rail 
frames (for Cuplok) or up to three guard rails. 

1.6. Cantilever platforms can be built around the perimeter of the birdcage, and it is possible to 
build cantilever platforms along part of the perimeter if required. 

1.7. Bridges can be built through the birdcage – with or without beams – with up to one bridge 
per lift level. 

1.8. Sheeting and debris netting can be fitted around all or part of the birdcage. 

1.9. Individual bay lengths and widths of system birdcages can be defined with the Setting-Out 
View. 

1.10. Sole boards or sole pads may be placed under all, or part, of the birdcage. 

2. Anchors can now be added to independent scaffolding. 

2.1. Several anchor patterns are available: the six TG20 patterns for tube-and-fitting scaffolding, 
four patterns for UK Cuplok scaffolding, and four patterns for Dutch Cuplok scaffolding. The 
patterns can vary for each elevation of scaffolding if required. 

2.2. Anchor positions are shown in the 3D model and the total number of anchors is included in 
the on-screen Quantities display. 

2.3. The TG20 rules for the placement of anchors with sheeting or a pavement lift are 
automatically followed. 

2.4. Anchor positions are included in the Cuplok drawings, and the components required to build 
them are included in the Cuplok material list. 

3. External ladders can now be placed against an independent or birdcage scaffold, with or 
without a ladder safety gate. 

4. Several improvements have been made to cantilever platforms: 

4.1. Cantilever platforms can be built from timber (for tube-and-fitting and UK Cuplok 
scaffolding) or from timber, steel, aluminium, or a combination of steel and aluminium (for 
Dutch Cuplok scaffolding). 

4.2. The start and end positions of a cantilever platform can be specified per elevation, allowing a 
platform to be built around a bay window, for example. This is also true for inside boards, 
which can now be built along part of an elevation. 
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4.3. It is now possible to place cantilever platforms of different widths on different lifts if 
required. The available platform widths are determined by the available bracket sizes for 
system scaffolding, whereas tube-and-fitting scaffolds can now build platforms with hop-up 
brackets or as single-stage cantilever platforms. 

5. Foot lifts can now be used with stepped or sloping ground. 

6. The editing of elevation lengths has been improved, especially for ‘split’ elevations. 

7. Intermediate transoms can now be erased from a non-boarded lift to model a structural lift. 

8. Inner guard rails can now be placed per lift. 

9. Lacing and bracing tubes are now modelled between bridge beams. 

10. Several improvements have been made to the Cuplok drawings: 

10.1. A dimensioned plan drawing of the whole scaffold is now provided. The scaffold elevations 
are numbered in the plan to match the individual elevation drawings and act as a key plan. 

10.2. Elevations that have been ‘split’ in the 3D model are now drawn together in one elevation 
drawing, allowing complex elevations to be drawn with: stepped heights, multiple gable 
ends, several slopes or steps on one elevation, or more than one bridge along one lift. 

10.3. Sheeting and debris netting are now shown in the drawings. 

10.4. The ground profile is now drawn under the base plates. 

11. Several improvements have been made to the Cuplok material list: 

11.1. The Cuplok material list can now be exported to Microsoft Excel. 

11.2. The total number of components is now displayed. 

11.3. The ‘preferred components’ Cuplok material configuration now allows components to be 
selected per scaffold type. For example, it allows a 2.5m horizontal to be used as a birdcage 
transom but not as an independent scaffolding transom, if required. 

12. Several improvements have been made to the modelling of Cuplok scaffolding: 

12.1. Plan bracing can now be optionally applied to Cuplok scaffolding (as well as to tube-and-
fitting scaffolding, as in previous versions). 

12.2. Dutch Cuplok platforms can now be built with combinations of decks of different widths. 

12.3. Dutch Cuplok scaffolding can now be built with H-frames. 

13. The system scaffolding Setting-Out View has been improved: 

13.1. The setting-out blocks are now split into lifts and bays, rather than just bays, to show gable 
lifts and lifts that are built on sloping ground. 

13.2. The width of each bay is now shown using a colour, making it easy to see the width of each 
scaffolding elevation (for independent scaffolds) or bay of scaffolding (for birdcages). 

13.3. System staircases are now included in the Setting-Out View. 

13.4. The calculation of bay lengths has been improved to use fewer bays in many cases. 

14. The on-screen Quantities display now shows the surface area of the scaffold (rather than the 
facade) to be more helpful for price estimation. It also now includes the total surface area of 
decking. 

15. The display of the 3D model is now smoothed, for graphics cards that support it. 
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Version 2.0 (Build 86): March 2010 
The following enhancements have been made in this version of SMART Estimator: 

1. It is now possible to create an independent scaffold using either tube-and-fitting or the 
Cuplok scaffolding system. The use of Cuplok requires an upgrade to your hardware key, so 
please contact CADS for more information. 

1.1. A new ‘Setting-Out View’ is available for system scaffolding that helps you to easily set out 
the scaffolding bays around a building. The scaffolding bays are represented by coloured 
blocks, enabling you to see the scaffold dimensions at a glance. You can even print the 
setting-out view to help you to set-out the scaffold on site. 

1.2. A new facility has been provided to specify the maximum gap between the scaffold and the 
building, which is used when setting out the scaffold. 

1.3. An automatic layout is provided, with options provided to override the automatic bay 
lengths and to alter the priority of the scaffolding at returns. 

2. Drawings and material lists can now be created for Cuplok scaffolding. At present the UK and 
Dutch variants of the Cuplok catalogue are supported. This feature requires an upgrade to 
your hardware key. 

2.1. The drawings and material list can be configured to only use the components that you have 
available, so for example it is possible to configure the available lengths of standards, ledgers 
and transoms. 

2.2. Drawings and materials lists are available for Cuplok independents and staircases. 

3. Cuplok scaffolds can now be exported to the SCIA Engineer structural software for analysis 
and design. This feature requires an upgrade to your hardware key and is presently available 
for the Dutch Cuplok catalogue. 

4. The following improvements have been made to the scaffold modelling: 

4.1. Sole pads can now be used under each base plate instead of sole boards that span between 
two base plates, if preferred. 

4.2. Bridges can now be created with a ladder beam, a unit beam, or without a beam. 

4.3. The scaffold platforms can now be built from timber, steel, or aluminium decks, while toe 
boards can now be built from timber or steel. 

4.4. Ladders can now be placed between boarded lifts, with a maximum height of one lift, or 
across boarded lifts as preferred. 

4.5. A foot lift can now be placed, the height of which can be specified. 

4.6. A new option has been provided to use double guard rail frames for system scaffolding. 

4.7. Scale figures can now be placed at the ground level for use when creating graphical 
visualisations. Two figures are available: a pedestrian and a scaffolder. 

5. The volume of the scaffold in cubic metres is now reported in the quantities. 

6. The user-interface theme has been updated to match SMART Estimator 2.0. It is possible to 
restore the previous theme, or to choose one of several themes that have been provided. 

7. This version is compatible with the 32-bit and 64-bit versions of Microsoft Windows 7. 

8. This version of Modelling is now available in two languages: English and Dutch. 
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Version 1.1 (Build 42): August 2009 
The following enhancements have been made in this version of SMART Estimator: 

1. 3D system staircases can now be created, either as a standalone item or attached to an 
independent scaffold. 

2. Safety lamps can now be added to standards, in one of two styles. 

3. Hop-up brackets may be added, up to three boards wide. An option is available to specify 
the spacing of the brackets, adding extra standards where required, and it is possible to alter 
the vertical position of the cantilever platform. 

4. Double standards may be added, either to the full height of the scaffold or to a specified 
height. 

5. A gin wheel and rope may now be added to the scaffold. 

6. The building facade can now be hidden, allowing pictures of the scaffold to be taken as 
standalone structures. 

7. An estimate of the total length of tube required for the scaffold is now displayed in the 
quantities. 

8. The scaffold library has been improved to allow library items and item groups to be renamed 
and deleted. 

The following corrections have been made: 

1. Sole boards are now omitted when bridged. 
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Version 1.0 (Build 32): May 2009 
The first release of SMART Estimator, with the following features: 

1. 3D models of independent scaffolds can be created, either from a standard building shape or 
by drawing a plan view. Complex scaffolds can be created, including curved and angular 
plans. 

2. The following scaffolding features are supported: 

2.1. Boarded lifts, un-boarded lifts, and landings; 

2.2. Ladders, including multiple ladders per elevation and ladders from the first lift; 

2.3. TG20:08 bracing patterns: single- and double-bay facade bracing, ledger bracing, and plan 
bracing. It is also possible to erase the ledger bracing below the first lift to create a 
pavement lift; 

2.4. Guard rail options: double or triple rails on working lifts, with up to three guard rails on non-
working lifts. The TG20:08 and SG04:05 recommendation of double guard rails on working 
lifts and single guard rails on non-working lifts is provided by default; 

2.5. Bridges built with pairs of beams; 

2.6. Plastic sheeting and debris netting in a variety of colours; 

2.7. Brick guards; 

2.8. Rubbish chutes in red or yellow; 

2.9. Safety standards, in red-and-white or black-and-yellow configurations, plus foam sleeves; 

2.10. Light-duty cantilever fans constructed from boards, corrugated iron sheets, or sheeting; 

2.11. Your configurable company banner, for display on the scaffold. 

3. The following scaffolding quantities are automatically produced: total elevation area, total 
lift length, total length of boards, total length of beams, total sheeting area, total length of 
rubbish chutes, total length of cantilever fans, and total length of brick guards. 

4. Scaffolds can be saved to file, saved as picture files, or saved in a library for reuse. Scaffold 
pictures can also be copied-and-pasted into other applications, such as Microsoft Word. 

5. Undo and redo features are supported. 

6. The 3D view can be manipulated by zooming, rotating, and panning, with pre-set views 
provided. 


